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The following changes were made:

— Fixed minor internal linking issues

— Fixed incorrect use of backslash in Workspace Messenger section

The following changes were made:

— Update to the Troubleshooting appendix regarding the MMD installation issue

— Minor update to Protocol support

— Renaming RDP to Delivery Platform (corporate rebranding)

— Updated Server software > Versions section

This version addresses the following:

— Table rendering issues

— Internal document links

Further clarification of Protocol support

Minor changes to the following sections:

— Streaming protocols

— Protocol support

Global release version, containing:

— A minor change to the Configuring multiple servers section.

— A known issue affecting Datastream for Office (DFO) users only.

Updating links to point to new LSEG site.

The following changes were made.

— New digital certificates

— The DPRM connection issue, affecting Workspace 1.23 only, has been fixed.

Added Appendix H: Unsupported packaging methods.

Updated Appendix J: Known issues to include DPRM connection issue.

The following changes were made:

— Guide rebranded for initial LSEG Workspace pre-release.

— Additional features added to the Configuration Manager

The following changes were made:

— Added Admin configuration to the Configuration override order section

— Added the disabled contribution sources setting to the shared configuration Settings
table.

The following changes were made:

— The Refinitiv ribbon add-ins table was updated

— Added the Streaming protocols section

— Minor changes to the shared configuration Settings table

— Removed a no longer supported feature from the Logging section

— Removed a fixed shared configuration file issue from the Appendix I: Known issues
section

The System Test app is now described in its own guide, which can be found here:

— Workspace System Test Guide

This release contains the following changes:

— Added Configuring multiple servers section

— Updated the Appendix J: Known issues section

Minor URL amendments

This version contains the following updates:

— Added Uninstalling Workspace with custom paths to the Known issues section.

This version contains the following updates:

— Added Logs Viewer section

— Updated the --help commands

— Updated the Error codes section

— Added Mass deployment section

— Revised the Default folder structures section

— Some additional Workspace executable statements

— Minor changes throughout to cover the new Workspace installer

This version contains information about the following updates:

— New appendix covering shared configuration file creation and settings

— ADH documentation location added

— Updated executable statement parameters

— Updates to Security section, including addition of TLS subsection

— Minor changes to the Example domain list

— Minor update to the DPRM section
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About this document 6

About this document

This guide describes IT-managed installations to platforms running on the following
environments®:

— Microsoft® Windows® directly
—  Citrix®?, specifically:

— Windows application virtualization with Citrix XenApp® (published app or published
desktop)
— Windows desktop OS virtualization with Citrix XenDesktop®

- VMware?, specifically:

— Horizon 8 Connection Server, Agent, and Client
— Blast display protocol

This document also details the steps and any post-installation configuration and
customization that is required to install the application.

Intended readership

The LSEG Workspace Installation and Configuration Guide is intended for IT specialists that
are responsible for the installation and maintenance of Workspace and Messenger
standalone.

LSEG Workspace rebranding

This first phase of LSEG Workspace rebranding is entirely cosmetic. For changes of a
technical nature that may impact your installation and maintenance of Workspace, you will be
given a minimum of nine months of notice, our standard obsolescence period, through the
PCN system.

Software releases and end of life

Refer to the Workspace Support Policy, which can be found in the documentation section of
the LSEG Workspace page.

For further information, see:
— PCN208374 — LSEG Workspace — Rolling obsolescence policy
— Workspace Support and Obsolescence FAQ

1 Instructions for macOS installation are provided in the Workspace Basic Installation Guide.

2 LSEG currently provides limited testing support and technical advice on Citrix Virtual Apps and Desktops (CVAD) solutions.
However, customers deploying a CVAD solution should consider the following when deploying, updating, and running
Workspace:

— The impact of network latency and equipment used.
— The potential for virtualization machines to adversely affect performance for end users.
— Legacy products such as Eikon will not work in parallel with Workspace

3 As summarized for Citrix, above, LSEG currently provides limited testing support for VMware and the same considerations

should be applied when deploying.
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| | I
Contact information

To receive further assistance, contact Support.
You can also provide feedback regarding this document through DocFeedback@I|seg.com.
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Pre-requisites

This section summarizes the information of which you should be aware prior to commencing
the installation of Workspace.

In this section

— Verifying system requirements
— Virtualized environments

Verifying system requirements | reateo uins

. . — Download locations
Before installing Workspace, ensure that your hardware and

software meet the minimum requirements.

Important: For an installation, creating a Workspace test user ID is highly recommended
to validate the installation. For further assistance, contact your account team or Customer
Success Manager.

LSEG strongly recommends that 3D Graphics Processing Unit (GPU) acceleration is
enabled. Workspace is based on Chromium, which uses the GPU for rendering
environments.

System and network testing

The System Test application helps you determine whether your computer meets the
minimum hardware, software, and connectivity requirements to run Workspace. No personal
information is sent to LSEG during this process.

For further information regarding the System Test applications, refer to the System Test
Guide.

Virtualized environments

When designing a deployed solution, individual utilization should be considered in the
planning. If specific information is required, it is recommended that a selection of pilot users
is monitored so benchmark testing can be performed by the relevant vendor support team.

Important: If you encounter an issue; LSEG requests that you confirm the issue has been

reproduced in a non-virtualized environment.

VDI support

Support is included with your subscription, when Workspace is installed according to our
system requirements on a standalone desktop PC for one user.

Due to the inherently complex and distributed nature of these solutions, we cannot offer the
same unconditional support as a standard desktop for the following:

— Terminal/Citrix Server
-  VMware Server
— Other multi-user or virtualized environments

LSEG Workspace Installation and Configuration Guide
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Help with installing and/or operating our software in these environments is strictly limited to a
commercially reasonable effort. While this document makes every attempt to highlight the
issues you may encounter, we can make no guarantees regarding a successful outcome.

If you encounter problems, we cannot investigate or escalate unless the issue is reproducible
on a standalone desktop running Workspace, in a single instance environment.
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Installing Workspace

Workspace can be installed on Windows, as a User or Machine Installation, and deployed to
CVAD.

However, it is recognized that there is much innovation and change in our marketplace. As
such, the content of this document is updated, as warranted by future changes in the
marketplace, and the evolving needs of our software products.

In this section

— PCinstallation

— Citrix installation

— VMware installation

— Running Workspace Web access
— Post installation testing

PC Installation

— Command line statements
This section discusses the installation of Workspace onto — Registry files

personal computers. — Error codes

Installation method summary table

Parameter Location Updated Windows service
Installation* Launch/Update automatically required
--user %LocalAppData% o =
—--machine-autoupdate-service %ProgramFiles% %ProgramData% o [
--machine-autoupdate-no %ProgramfFiles)% %ProgramData% = =
--machine-autoupdate-peruser ° %ProgramFiles% %LocalAppData%® Launch / Update -
location only

Workspace Help parameter options

When installing Workspace, you can use the --help parameter to list all parameters that are
available.

The Command Prompt also lists all error codes that could be displayed during a Workspace
installation. These codes are listed in the Error codes section.

Command line statements have the following structure, where one or more <option>
parameters are non-mandatory:

RefinitivWorkspace-instalTler_x.xx.xx.exe <operation> <option>

4 Default locations. These are customizable during installation.

5 See Important note in Uninstalling Workspace.

6 A copy of the Installation (master image) will be created for each user when they first log into the machine. If the version of
the master image changes, the local version is refreshed when a user next logs in.

LSEG Workspace Installation and Configuration Guide
Document Version 124.08




Installing Workspace 11

All parameters are listed alphabetically in the following table:

Parameter

<operation>
--machine-autoupdate-no
—--machine-autoupdate-peruser
--machine-autoupdate-service
—--uninstall

--user

Purpose

Machine installation, with no auto-updates.

Machine installation, with an auto-update per user.
Machine installation, with an auto-update service.
Uninstall Workspace.

User installation. This is the default installation option.

<option>
--cachepath="<Your cache
path>"

--client-sso="<Your
ClientSSO URL>"

--forceInstall’
—-help

-—installpath="<Your install
path>"

--installerlogpath="<Your
install log path>”

--Tang="<lang>"

--logpath="<Your log path>"
--messengeronly

--sharedconfig="<shared
config file path>”

--shortcut-excel=<FALSE /
TRUE>

--shortcut-workspace=<FALSE
/ TRUE>

--shortcuts="<"Your
shortcuts path>”

--silent @

Specify the cache file path.

Allows you to set up Single Sign-On (SSO), once Workspace has completed
installation. SSO settings are stored in either user-settings.json or machine-
settings.json, depending on which installation mode was used for Workspace.

Skips the check to ensure your system meets the pre-requisites.
Displays the list of parameters in a second command prompt window.
Specify the installation path.

Specify the installation log file path.

Allows you to specify the installation language. Where <lang> is:

en English
ja Japanese
zh Chinese
ko Korean

Specify the log files path.

Installs Workspace Messenger only. This installation mode will not share the login
session with Workspace.

Specify the path to a shared configuration file.

Setting this parameter to false installs the product without the Refinitiv Workspace -
Excel shortcut

Setting this parameter to false installs the product without the Refinitiv Workspace
shortcut.

Specify the location of the Refinitiv Workspace and Refinitiv Workspace - Excel
shortcuts. Enter NONE to hide the shortcuts.

No information messages are displayed during installation.

Customizing paths

During the installation, you have the option of determining your own path for installation files,
logs, cache files, and shortcuts. To do this, use one of the following commands:

Action Command

Change install location
Change log location

Change cache location®
Change icon shortcut location
Change installer log path

Refinitiviorkspace-installer_x.xx.xx.exe --installpath="<folder_path>"
RefinitiviWorkspace-installer_x.xx.xx.exe --logpath="<folder_path>"
Refinitiviorkspace-installer_x.xx.xx.exe --cachepath="<folder_path>"
Refinitiviorkspace-installer_x.xx.xx.exe --shortcuts="<folder_path>"
Refinitiviorkspace-installer_x.xx.xx.exe --installerlogpath="<folder_path>"

You can use multiple parameters in one command line. For example:

RefinitivWorkspace-installer_x.xx.xx.exe --installpath="<folder path>”
-—-cachepath="<folder_path>"

~

experience.

© ©

Do not use this flag without a clear purpose and understanding of the impacts, as it may result in degraded product

Silent mode is enabled when installing, updating, or uninstalling Workspace, using the command line.
See Cache path definition in the Known issues section.

LSEG Workspace Installation and Configuration Guide
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Performing a User installation

When you perform a user installation, files are created in the
%LocalAppData%\Refinitiv\Refinitiv Workspace\

folder.

To install Workspace on a user basis:
1. Download the Workspace package.
2. Run the .exe file or use the Workspace command lines using the command prompt app.

In a user installation, administrator rights are not required.*°
3. Follow the on-screen instructions to install Workspace **:

Installing Workspace 12

RELATED LINKS
— Download locations

Welcome to

LSEG
Workspace

$O% LSEG

LSEG
Workspace

License Agresment

Applications

LSEG Workspace.

LSEG Messenger

LSEG Installation
Workspace

x o msTaL “

Performing a Machine installation 2

With the auto-update Windows service
This is the recommended installation mode and is the preferred method for your

organization, where:

RELATED LINKS
— Installation statements

— Users are not allowed to run programs from areas where they have no write permissions

on %ProgramFiles%.

— Applications are reviewed before being approved across your organization, to ensure that
they do not undermine application whitelisting. This is especially important for scripting

languages, which have their own execution environment.
For this installation, files are created in the following folder:

Installation
Default

Type of OS
Windows

Path

%ProgramfFiles%\Refinitiv\Refinitiv Workspace\

10 To review help for the Refinitiviorkspace-installer_x.xx.xx.exe command, add the parameter —-help.
11 For further details, see the Workspace Basic Installation Guide.

12 To perform any per machine installation, you require administrator access rights.

LSEG Workspace Installation and Configuration Guide

Document Version 124.08


https://workspace.refinitiv.com/
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/basic-installation-guide.pdf

Installing Workspace 13

To install Workspace on a machine basis:

LSEG .
1. Download the Workspace package Workspace Installation Type
. . Select how you want to install the software.
2. Do either of the following: L Ao
a. Run the executable, taking the Install for all o instatforme ony
users on this computer option13 s

Install for all users of this computer

- Or
a. Open a Command Prompt window
b. Run Refinitivorkspace-
installer_x.xx.xx.exe --machine-

autoupdate-service -- o
sharedconfig="<file path>" '’ S =

With auto-update per user
This installation mode * is the preferred method for your organization, where:

— Users are not allowed to run programs from areas where they have no write permissions
on %ProgramFiles%.

— Applications are reviewed before being approved across your organization, to ensure that
they do not undermine application whitelisting. This is especially important for scripting
languages, which have their own execution environment.

For this installation, files are created in the following folders:

Type of OS Installation Path
Windows Master image %ProgramFiles%\Refinitiv\Refinitiv Workspace\
Copy ®1¢ %LocalAppData%\Refinitiv\Refinitiv Workspace\

Important: The master image must be updated on a regular basis — in accordance with

the — to avoid the situation where a new user on a machine can install a
version of Workspace into their profile that is no longer supported.

To install Workspace on a machine basis:
1. Download the Workspace package
2. Open a Command Prompt window

3. Run RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-
peruser --sharedconfig="<file path>"1’

Without auto-updates

This installation mode is the preferred method for organization running hot-desking, gold
images, non-Persistent VDIs, or Provisioning Services (PVS) with configuration to clear
changes once user close their Windows sessions.

13 For further information, see the Workspace Basic Installation Guide.

14 See Important note in Uninstalling Workspace.

15 Copy installation location.

16 Once the master image has been copied to the profile of the user, the user needs to restart their machine.

17 Defining a shared configuration file (or files, for failover purposes) is optional but strongly recommended for mass
configuration.

LSEG Workspace Installation and Configuration Guide
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For this installation, files are created in the following folder:
Type of OS Installation Path

Windows Default %ProgramFiles%\Refinitiv\Refinitiv Workspace\
To install Workspace without auto-updates:
4. Download the Workspace package
5. Open a Command Prompt window

6. Run RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no
--sharedconfig="<file path>"*’

Performing an installation using your | reiareo cinks
Single Slgn On URL — Installation statements

— Configuring Single Sign On
(SSO) for Workspace web

Using a shared configuration file access _
— Setting up config manager

Defining a shared configuration file (or files, for failover
purposes) is optional but strongly recommended for mass configuration.

Using the command line

To install Workspace using your Single Sign On (SSO) URL, do the following:
1. Download the Workspace package.
2. Open a Command Prompt window.

3. Add the appropriate parameter from the table below 8, depending on your environment:

Environment Additional installation parameters Settings location
User -—-client-sso=<client SSO URL> user-settings.json
Machine --client-sso=<client SSO URL> machine-settings.json

Citrix installation

This section addresses the currently supported scenarios for Workspace deployment to
CVAD. However, it is also recognized that there is much innovation and change in our
marketplace. As such, the content is updated, as warranted by future changes in the
marketplace, and the evolving needs of our software products.

Important! Workspace installers require administrator rights to create their own registry

path entries.

Installing Workspace for Citrix RELATED LINKS
— Customizing installati
XenApp p:t?];)mlzmg installation
. . . — Appendix C: Command line
1. Check that no previous Eikon registry keys are set. statements

18 This parameter should be added to the installer executable, also in combination with additional parameters.

LSEG Workspace Installation and Configuration Guide
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2. Ensure that the following registry keys are applied, to disable Citrix API hooks for a single
executable file: *°

CVAD 7

Version 1912 LTSR

XenApp 7.6 LTSR XenApp 7.15 LTSR %

AR g oo HKLM\SYSTEM\CurrentControlSet\ser

Key(s) No HKLM\SOFTWARE\Wow6432Node\Ci trix\ . .
- modification CtxHook vices\CtxUvi
Value name tokzeyg;si;ry ExcTudedImageNames UviProcessExcludes
Type required REG_SZ REG_SZ
Value to add % RefinitivWorkspace.exe % RefinitivWorkspace.exe

3. To show the Workspace context menu when right-clicking the Windows taskbar, refer to
the Citrix Support Knowledge Center article CTX131995, User Cannot Launch
Application in Seamless Mode in a Provisioning Services Server when XenApp
Optimization Best Practices are Applied.

4. On the Citrix server, to change to installation mode, use the command line:
Change user /install

5. To install Workspace, use the following command line, which includes the log and cache
paths 23, which must point to the same location from where Refinitiviorkspace.exe is
run:

— RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --
Togpath="<folder_path>" --cachepath="<folder_path>”

— However, it is recommended that you define a shared configuration file (or files, for
failover purposes) using the —-sharedconfig="<f7Te_path>" parameter 2. This is
optional but strongly recommended for mass configuration.

6. Once the installation has finished, change back to execute mode, using the command
line:

- Change User /execute

Publishing Workspace applications for XenApp

To complete the installation, you must publish both Workspace and Refinitiv Workspace -
Excel applications in Citrix XenApp.

To do this, use your usual configuration software, whether Citrix or third party, with the
following parameter settings:

Product Parameter Setting

Workspace Path to the executable file <installation_ path>\Refinitiviorkspace.exe
Working directory <installation_path>

Workspace for Excel Path to the executable file <installation_path>\RefinitivWorkspace.exe
Command line argument —-excel
Working directory <installation_path>

1% For further information, see https:\\support.citrix.com\article\CTX107825.

20 Reboot from the VDA required.

21 Process names have a 14-character limit. For example, to exclude Tongappname. exe, you add Tongappname.ex.
22 |f you want to use the Session Sharing Chrome Extension, add Refinitiv-host.exe.

2 See Cache path definition in the Appendix J: Known issues section.

24 For further information, see step 3 of Setting up configuration manager.
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Installing Workspace for Citrix RELATED LINKS
Xen DeSktOp — Without auto-updates

If you use gold images, non-Persistent VDIs, or Provisioning Services (PVS) with
configuration to clear changes after the user closes a session, you must install Workspace in
without auto-updates mode using the following argument:

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --
sharedconfig=“<file path>”

In most cases, the Per-Machine and Per-User installation modes of Workspace are also
supported in Citrix XenDesktop.

® Log and Cache paths must point to the location from where RefinitiviWorkspace.exe
IS run.

VMware installation

This section describes the installation of products that are required for Workspace
deployment to VMware.

Installing Workspace for VMWare Horizon virtual app

1. Change to installation mode:
On the Horizon server, use the command line:
change user /install

2. Install Workspace:

In a command-line interpreter, such as Command Prompt, type the following command
line 25:

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --
Togpath="<folder_path>" --cachepath="<folder_path>" 26

Important! It is strongly recommended, particularly for mass configuration, that you

define a shared configuration file (or multiple files, for failover purposes). This is done
by using the --sharedconfig="<file_path>" parameter.

3. Return to execute mode:

Once the installation has finished, change back to execute mode, using the following
command line:

change user /execute

%5 The command line is run from the folder where Refinitivilorkspace.exe file is located and contains paths to the required
log and cache file locations.

26 |t is strongly recommended, particularly for mass configuration, that you define a shared configuration file (or multiple files,
for failover purposes). This is done by using the --sharedconfig="<fi1le_path>" parameter.
For further information about shared configuration files, see step 3 of the Setting up configuration manager.
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Configuring virtual applications on Windows Server

Installation is completed by publishing both Workspace and Refinitiv Workspace - Excel
applications in the VMWare Horizon virtual app.

To publish the applications, perform the following steps using the Horizon Console:

1.
2.

In Horizon Console, select Inventory > Applications

In the Application Pools panel, select Add >
Add Manually

For Workspace, in the Add Application
Pool panel, complete the form using the
following detalils:

In this field... Type or select this ...

ID RefinitivWorkspace

Display Name Refinitiv Workspace ¥

Path <install_path>Refinitiv\Refinitiv
Workspace\RefinitivWorkspace.exe

Start Folder <install_path>\Refinitiv\Refiniti

v Workspace\

Entitle Users Select this checkbox
after Adding
Pool
Multi-Session

Mode

Select Disabled

Click Submit

The application appears in the Application
Pools panel

Select Add > Add Manually

For Refinitiv Workspace - Excel, complete
the form using the following details:

In this field... Type or select this...

Application Pools

O Display Name Pl or Farm versian Enable

ID RefinitivWorkspaceExcel

Display Name Refinitiv Workspace - Excel %

Path <install_path>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe
Start Folder <install_path>\Refinitiv\Refinitiv Workspace\

Parameter --excel

Select this checkbox
Select Disabled

Entitle Users after Adding Pool
Multi-Session Mode

Click Submit

The application appears in the Application Pools panel

27

The Display Name value is a free text field. However, the structure of the ID, Path, and Start Folder entries are a

requirement.
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8. Inthe Application Pools panel, click
Entitlements

9. Inthe Add Entitlements panel, click Add

The Find User or Group panel, opposite, is
displayed

10. Use the fields in this panel — Domain,
Name/User Name, and Description —
search for existing VMware users and select e
the checkboxes next to their details

11. Click OK

Installing Workspace for
VMWare Horizon virtual
desktop

If you use instant clone desktop pools (golden image), or automated full-clone desktop pools,
configured to clear changes after the user closes a session, you must install Workspace
using the no automatic update mode. To do so, use the following command line?s:

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --
sharedconfig="<file_path>"

In most cases, the Per-Machine and Per-User installation modes of Workspace are also
supported for VMware Horizon virtual desktop.

Running Workspace web
— Configuring Single Sign On
aCCGSS \(sgr(lzggc;rcgrowser-based

Workspace is also accessible through the Internet or private
network.

Accessing through the Internet
To access the Workspace sign-in page:

— Enter the following URL into your browser:

— https:\\workspace.refinitiv.com\web

Accessing through a private network
To access the Workspace sign-in page:

— Enter the following URL into your browser:

— https:\\workspace.extranet.refinitiv.biz\web

28 Although not shown in this example, as for the virtual app, the command line should include the log and cache paths, which
must point to the same location from where RefinitiviWorkspace.exe is run.
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Post installation testing

Once Workspace has been installed, you can test the data retrieval functions using the
testing tool provided in Refinitiv Workspace - Excel.

Downloading the tool

To download the testing tool, do the following:

1.
2.

a. Signin, if necessary

Run Refinitiv Workspace - Excel
Under the Workspace menu:

b. Click Templates

c. In Search for templates..., type test and
press Enter

d. Inthe first search result panel, Refinitiv Workspace — Microsoft Excel Functions Test,
click the Download button

Once downloaded, the tool template opens automatically:

AutoSave (@ 0f) Refinitiv Warkspace Microsoft Bxcel Functions Testxlsm - Protected View = el Keeling, Duncan KD

File Home Insert Page Layout Formulas Data Review View Help Acrobat Refinitiv Refinitiv 365

\U PROTECTED VIEW Be careful—files from the Internet can contain viruses. Unless you need to edit, it's safer to stay in Protected View. Enable Editing x

R12 - Je v
A B C D B F G H | J K L M i 0 P Gl

B REFINITIV [ REFINITIV WORKSPACE - MICROSOFT EXCEL FUNCTIONS TEST version 1.0

2

3

N PURPOSE:

1 ———r g I B . e P . ‘_L'&J

y P - . N ; — =

gé REQUIRED INPUTS

27 K NP D RIPTION -

3 Instructions Results TESTO1-DATA-RT TEST02-DATA-FRD TEST03-DATA-TS TESTO04-DATA-SEARCH TESTO5-Di ... 4 »
Ready HH - ] + 100%

Running the tool

After checking the Prerequisites, listed in the Instructions section, do the following:

1.
2.

Click the Results worksheet tab
Click the START THE TEST button

The tests usually take less than a minute to run and, should an error occur, you are
presented with diagnostic data under the relevant tab.
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Uninstalling
Workspace

You can uninstall Workspace, by:
— Using the installer user interface, or
— Using a command

Using the installer user interface

You can uninstall Workspace using the standard add and remove functions in Windows and
macOS 2°. For example:

1. In Windows, under Settings > Apps & features, RS—
select Refinitiv Workspace and click Uninstall Westsoace LSEG Workspace Uninataler
2. Inthe confirmation prompt, click Uninstall again O umes G

to open the installer Ul, opposite
3. Click Uninstall
4. Once the uninstallation is complete, click Exit

Using a command

You can uninstall Workspace using the following
command line:

This will remove all files, folders, and registry keys.

— RefinitivWorkspace.exe --uninstall

Important: When the --machine-autoupdate-peruser installation method is used,
running the uninstallation command removes the Workspace instance in the profile under

which it is run. For instance, if the master image is removed, all clone images will remain
installed.

Log file location

The uninstallation log file is stored in the %Temp%\Refinitiv Workspace Uninstall
Logs\ folder.

2 The app removal function in macOS deletes the application folder without displaying the Workspace-specific Ul.

LSEG Workspace Installation and Configuration Guide
Document Version 124.08




Running a mass deployment 21

Running a mass deployment

About mass deployment

You can deploy LSEG Waorkspace with your own mass deployment tool. To do so, follow the
four stages summarized below:

Stage 1: Prepare installation and shared configuration files
Stage 2: Prepare the installation command line and create an install script

Stage 3: Ensure that the installation, shared configuration, and the install script files are in a
shared location

Stage 4: Execute the install script or command line using your mass deployment tool

Prepare installation and shared configuration files

1. Download the Workspace Installer from the Workspace download page. The file has the
following naming structure, where x. xx. xx is the version number:

— RefinitivWorkspace-installer_x.xx.xx.exe
2. Create a config. json file

— For example:

{
"EIKON.CONNECTION.MODE": "private",
"EIKON.LOG.TRACELEVEL": "warn",
"REFINITIV.WORKSPACE.RUN_ABOVE_NORMAL_PRIORITY": "true",
"REFINITIV.WORKSPACE.TRADING.PRINTER_NAME": "Microsoft Print to PDF",
"EIKON.INTRANET_OVERRIDE.URL": "C:\\Workspace\\config.json",
"CLIENTSSO_URL.ENABLED": "true",
"CLIENTSSO_URL": "https:\\myapps.testsso.com",
"CLIENTSSO_REFINITIV_URL": "https:\\myapps.testsso.com",
"EIKON.STREAMING.API.LOCAL.ENABLE": "true",
"EIKON.STREAMING.API.LOCAL.SESSIONS": "[\"wss:\\test-ads-
sharedconfig.com:15000\WebSocket\" ] ",
"EIKON.STREAMING.APTI.LOCAL.DACS.USERNAME": "permit_all_exchanges",
"EIKON.STREAMING.API.LOCAL.DACS.POSITION":

"%USERDETAILS . LASTNAME%_%USERDETAILS.UUID",
"EIKON.STREAMING.API.LOCAL.DEFAULTSOURCE": "IDN_RDF_2",
"EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION.ENABLE": "true",
"EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION": "3000",
"EIKONPROTOCOL . ISDEFAULTAPPLICATION": "true"

Prepare the installation command line and an install
script

For further information about installation command lines, refer to the Workspace Help
parameter options section, under PC installation.

For an example of an install script (install.cmd), see the Script examples section.
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Ensure all necessary files are in a shared location

The following files must be in a common location:

RefinitivWorkspace-installer_x.xx.xx.exe
config.json

config_fallback.json (optional)

install.cmd

Execute the install script using your mass deployment
tool

Run the installation script using your deployment tool.

Script examples

This section contains examples of the following scripts for LSEG Workspace:

Installation
Update
Rollback
Uninstallation

Install (install.cmd) script example:

@echo off

—————- Identify the command's parameters to install the software
SET VERSION=1.20.38

SET REFINITIV_WORKSPACE_INSTALLER=C:\Workspace\RefinitivWorkspace-
installer %VERSION%.exe

SET REFINITIV_WORKSPACE_SHARED_CONFIG_FILE=C:\Workspace\config.json
SET

REFINITIV_WORKSPACE_SHARED_CONFIG_FALLBACK_FILE=C:\Workspace\config_fallbac

k.json

SET DEPLOYMENT_MODE=--machine-autoupdate-service

SET REFINITIV_WORKSPACE_INSTALL_PATH=C:\rw\installpath

SET REFINITIV_WORKSPACE_LOG_PATH=C:\rw_custpath\Tlog

SET REFINITIV_WORKSPACE_CACHE_PATH=C:\rw_custpath\cache

SET REFINITIV_WORKSPACE_SHORTCUTS_PATH=C:\rw_custpath\shortcuts
————— Workspace Installation ------

"VREFINITIV WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --

sharedconfig="%REFINITIV_WORKSPACE_SHARED_CONFIG_FILE%;%REFINITIV_WORKSPACE

_SHARED_CONFIG_FALLBACK_FILEX%" --silent;
11 "%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --

éharedconfig="%REFINITIV_WORKSPACE_SHARED_CONFIG_FILE%;%REFINITIV_WORKSPACE

_SHARED_CONFIG_FALLBACK_FILE% --
installpath="%REFINITIV_WORKSPACE_INSTALL_PATH%" --
cachepath="%REFINITIV_WORKSPACE_CACHE_PATH%" --
Togpath="%REFINITIV_WORKSPACE_LOG_PATH%" --
shortcuts="%REFINITIV_WORKSPACE_SHORTCUTS_PATH%" ;
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Workspace update (update.cmd) script example:

@echo off
—————— Identify the command's parameters to install the software
SET VERSION=1.21.365
SET REFINITIV_WORKSPACE_INSTALLER=C:\Workspace\RefinitivWorkspace-
installer %VERSION%.exe
SET DEPLOYMENT_MODE=--machine-autoupdate-service
————— Workspace Software Update ------

"VREFINITIV WORKSPACE_INSTALLER%" %DEPLOYMENT_MODEY% --silent;

11 "%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --
sharedconfig="%REFINITIV_WORKSPACE_SHARED_CONFIG_FILE%;%REFINITIV_WORKSPACE_
SHARED_CONFIG_FALLBACK_FILE% --
installpath="%REFINITIV_WORKSPACE_INSTALL_PATH%" --
cachepath="%REFINITIV_WORKSPACE_CACHE_PATH%" -
Togpath="%REFINITIV_WORKSPACE_LOG_PATH%" --
shortcuts="%REFINITIV_WORKSPACE_SHORTCUTS_PATH%" ;

Rollback (rol1back.cmd) script example:

@echo off
—————— Identify the command's parameters to rollback the software

SET REFINITIV_WORKSPACE_INSTALL_PATH=C:\Program Files\Refinitiv\Refinitiv
Workspace

————— Workspace Uninstallation ------
"VREFINITIV WORKSPACE_INSTALL_PATH%\RefinitivWorkspace.exe" -rollback --
silent;

Uninstallation (uninstall.cmd) script example:

@echo off
—————— Identify the command's parameters to uninstall the software
SET REFINITIV_WORKSPACE_INSTALL_PATH=C:\Program Files\Refinitiv\Refinitiv
wOrkspace
————— Workspace Uninstallation ------
"VREFINITIV WORKSPACE_INSTALL_PATH%\RefinitivWorkspace.exe" -uninstall --
silent;
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Configuring

parameters

WO rkS p ace - ICIE]LtJ;tgg:er managed over

You can configure Workspace using the Configuration Manager, which is accessed by

running the Workspace
executable with the --config- S e
manager parameter in a Netwark I

Command Prompt window or by Client S50 O Prvase retwork

selecting the Help > Shared Configuration '

Configuration Manager option .

in Workspace. e

Other

In this section
— Setting up config manager

— Creating a new config file be
manually cocte

— Configuring Single Sign On
(SSO) for browser-based
Workspace

Configuration |
Manager command lines

The command line you use depends on the installation type:

IMPORT EXPORT APPLY CLOSE

— For User installations, use the command:

“<Instal1Dir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe”
--config-manager

— For Machine installations, use the command:

“<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe”
--config-manager --machine

Setting up configuration

—  Server software versions
Mmanager - Logs

—  Converting and modifying
In the Configuration Manager, choose your settings for the an Eikon configuration file

following panels:

1. Inthe Network panel, set the connection type in your environment to either Internet (the
default value) or private network.

2. Inthe Client SSO panel, if you have SAML 2.0 set up, enter the URL in the Client
Single Sign On (SSO) field.
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3. Inthe Shared Configuration panel, select whether you are using a shared configuration,
which overrides other settings.

Important! Defining a shared configuration file (or files, for failover purposes) is optional

but strongly recommended for mass configuration, as it allows you to define configuration
parameters for all users from a single location.

Workspace uses different settings. json files®® based on the type of installation:

— For User installations, the file stores user-specific settings that are controlled by the
user and can be found in the following location:

%AppData%k\Refinitiv\Refinitiv Workspace\Config\user-
settings.json

— For Machine or Hot-Desking installations, the file stores machine-specific settings that
are controlled by elevated computer administrator rights and can be found in the
following location:

%ProgramData%\Refinitiv\Refinitiv Workspace\Config\machine-
settings.json

You can specify one or, for failover purposes, more configuration files that can be used
across multiple desktops by putting these files on a shared drive or Web server (formerly
Configuration Proxy concept).

To do this:

a. Click Export and navigate to the configuration file, <override_settings>.json,
from the Configuration Manager.

b. Place this file on a shared drive or a Web server.

c. Enter the URL or UNC path of the file into the installation command line, or add this
path into the Configuration Manager directly. For example:

\\myserver\config\refinitiv\override-settings.json

4. Inthe Streaming panel, you can choose streaming sources and whether to activate

streaming conflation.

CONFIGURATION

The Streaming Conflation
rate 3 is used for desktop e
performance management by oA

Stream Data Retrieval

@ From LSEG

redUCIng CPU usage |n Shared Confiauraton (O From a local LSEG Real-Time Advanced Distribution Server (ADS)
downloading streaming data. Streaming *

In effect, it reduces data Printer

refresh rate from the default Other Sreaming Confaton”

[] Activate Conflation Rate: | 15 Seconds ¢

to every 1.5, 3, or 6 seconds.

5. Also, in the Streaming panel,
choose your Streaming Data | wov
Retrieval source. Data can

30 A shared <override_settings>.json configuration file takes priority over local user-settings.json or machine-

settings.json configuration files. When using the —-sharedconfig parameter, Workspace reads the configuration from
the specified location every time it is launched.

31 Currently, this capability is for Workspace desktop access only and will not affect the conflation settings of the Workspace
add-in running under Microsoft Office.

On Workspace desktop, the highest generally supported conflation rate is 300ms. However, certain exceptions, such as
news and chart apps, can run at higher update rates.
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be streamed from either a Delivery Platform (formerly RDP) or by defining one or more
local LSEG Real-Time Advanced Distribution Servers (formerly ADS).

In Configuration Manager32, you can configure the WebSocket * protocol to connect to
the Workspace platform for streaming services:

— WebSocket Secure (wss:\\) for encrypted connections, and
— WebSocket (ws:\\) for unencrypted connections

Additional customer-managed sites use this connectivity to create a connection to the
local LSEG Real-Time Advanced Distribution Server.

Some proxy servers may not support (or have disabled support for) the WebSocket
protocol, which may cause Workspace streaming-related features not to work.

You must do the following:

a. For Internet, allow WebSocket connectivity to the following URLS:

*.refinitiv.com
*.refinitiv.net

b. For Delivery Direct, allow WebSocket connectivity to the following URLS:

*.refinitiv.biz
*.refinitiv.net

In the Streaming > Servers
panel, enter the LSEG Real-
Time Advanced Distribution
Server IP address and
hostname, together with the
port 3. The default LSEG
Real-Time Distribution System
(formerly TREP) port for
WebSocket is 15000.

Click + to add multiple
servers, which are called in
turn if connection to the
Primary server fails.

LSEG Workspace Configuration Manager X

CONFIGURATION Advanced Distribution Servers (ADS) *
Network

Primary *
Client SSO

Protocol
Shared Configuration
I WebSocket o

Streaming *

Servers *

Feeds
| websocket

DACS

l“.’te:)S:ckel |
Printer
ADD SERVER
Other
[*] Random load balancing
ADVANCED
®© For each tab, by default the first ADS listed is used if a connection is
successful. Choose ‘Random Load Balancing' to select a different ADS
each time you start LSEG Workspace.

&Lﬁwr‘”‘r‘-"“osr‘w*,‘

Logs

In the Streaming > Feeds panel, configure feeds provided by local LSEG Real-Time

Advanced Distribution Server.

In supported Workspace versions, key letters3® can be used as single-character shortcuts
to additional feed sources. For example, LSEG Real-Time Advanced Transformation
Server (formerly ATS) is key letter A.

For Office aliases?®®, there is a limit of 32 characters.

In the Streaming > DACS panel, enter the LSEG Real-Time Data Access Control

System username and position.

32

33

34

35
36

Other protocols can be configured in your shared configuration file. For more information, see the Streaming protocols

section.

The WebSocket(ws) protocol provides full-duplex communication channels over a single TCP connection. For further
information, see RFC 6455: The WebSocket Protocol (rfc-editor.org).

Only one server or DNS can be entered for each line.

Workspace supports only standard ASCII (Latin) alphabetic characters. That is, the values A-to-Z or a-to-z.

A subset of ASCII printable characters is supported. That is, the values a-to-z, A-to-Z, and 0-to-9. Special characters (#, $,

&, and so on) are not supported.
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9. Inthe Printers panel, select the
default printer or output
mechanism that is to be used to
print trading tickets silently. That is,
without the need to select the
printer each time.

10. In the Other panel, you can
choose whether Workspace is to
run at above normal priority 3’ by
selecting the Run At the highest
Available Process Priority Level
checkbox. 38
You can also select whether links
from LSEG apps open in
Workspace or Eikon. %

Finally, the Select trading keypad
mode applies your chosen keypad
lighting scheme to the LSEG FX
trading keypad.

11. In the Logs panel, you can modify
the default path for log files,
changing from the folder path
chosen during installation.

You can choose the depth of
logging required.

You can also activate the web
logger to troubleshoot networking
issues.
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LSEG Workspace Configuration Manager b <

English
CONFIGURATION Trading Ticket Printing

Network

Client SSO

INone
Adobe PDF (Default)
Cloud Print Management - PCLXL
Fax

Shared Configuration

Streaming *

Sewvers:: Microsoft Print to PDF
Feeds Microsoft XPS D ument Writer
OneNote (Desktop)
LA OneNote for Windows 10
Printer | Snagit 2021
Othes ® Selected printer is used to automatically and silently print trading tickets.
ADVANCED
English
CONFIGURATION P
Network
[] Run at the Highest Available Process Priority Level
Client SSO

Shared Configuration

Streaming
Select the app that opens LSEG links
Printer
(® LSEG Workspace
Other
O Eikon 4
Select trading keypad mode
@ This setting takes effect when the keypad switches are in ‘software
mode’. Please refer to the documentation supplied with the keypad for
ADVANCED more details.
Logs
(O Advanced Dealing
Cache
O Advanced Trade Execution
Tools
O Focus mode (trading keys works with whichever application is selected)
1M EXPOR’ APPLY CLOSE

LSEG Workspace Configuration Manager X
English

CONFIGURATION

Logs Folder
Network Root path [ ‘ X £
Client SSO Full path (default): %LOCALAPPDATA%\RefinitiviRefinitiv Workspace Logs
Shared Configuration
Trace Level
Streaming *
O Debug &
Servers *
O Verbose A
Feeds
@ Information (default)
DACS
O Warning
Printer -
Q Error
Other 3
ADVANCED Web Logger
Logs

[ Activate web logger

Cach
,:ﬁﬁ..-,..._,w LI P 0 s IO o PO mnrtind

Currently, this capability is for Workspace running on Windows only and will not affect the process priority of Workspace on

macOS or the add-in running under Microsoft Office.

38 This can also be achieved by using the command line parameter —--run-above-normal-priority. For more information, see

Workspace executable statements.

39 You are unable to switch between Eikon 4.0 and Workspace where there was a Citrix installation of Workspace. In Citrix we
do not support multiple applications to be installed concurrently (Jira ref: EFO-9593).
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12. In the Cache panel, you can define 1555 Wotkopacs Confton o
a new folder location for cache Cocne Forder
files, changing from the folder path Networi Reot path
Chosen during insta”ation_ Client SSO Full path (default): %APPDATA%)\Refinitiv\Refinitiv Workspace\Cache
Shared Configuration
You can also choose to clear all Streaming e R
cache folders or only those folders Senvers * Clears cached cata oy for Electron
of Electron or your Workspace Feecs
DACS Clear app cache
apps Printer Clears cached data only for LSEG Workspace apps.
Other
e Clear all cache
o Clears all cached data

\J,J.,‘M*——-""")r"d

13. Finally, in the Tools panel, use the e e
Eikon 4 Conflguratlon converter CONFIGURATION EIKON 4 CONFIGURATION CONVERTER
tool to convert an existing Eikon - NI T A A
configuration file to Workspace- R
compatible . json format. Sucaming
N madh . A W Y

For further information, see the
section below.

Converting and modifying an Eikon
configuration file

For test purposes, in the Tools panel of the Configuration Manager, you can use the Eikon 4
configuration converter to convert an existing OverrideConfiguration.xm]l file to . json
format.

To convert and modify an existing file:

1. Click Eikon 4 Configuration Converter.

2. Select your saved .xml file. For example:
\\myserver\config\refinitiv\OverrideConfiguration.xml

3. Click Open.

The file is converted, and the converted configuration file is then displayed.

Click OK.

[Optional] Change your Network and SSO configuration.

Check that the Streaming settings are correct and make any necessary changes.

N o g s

Click Export to create a new file with a . json extension.

Warning: The converted . json file still contains legacy configuration settings from Eikon,

which could potentially raise issues.

Creating a new configuration file manually

To create a clean Workspace configuration file:
1. Delete your currently loaded configuration file.
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2. Copy specific parameters from the Eikon Configuration Manager to the Workspace
Configuration Manager.

Parameters in the Eikon Configuration Manager largely share the same names as their
counterparts in Workspace. However, the following table lists the exceptions (parameter
name and location):

Distributors Hostname or IP
Configuration: Customer Managed (Local Configuration Streaming > Servers
Files) > Real-Time tab > ADS Connection — RSSL protocol
User Name Username
Configuration: Customer Managed (Local Configuration Streaming > DACS

Files) > Permissions tab > DACS Identification

For more complex environments and further support, contact Workspace technical support,
who can assist in converting the content of the OverrideConfiguration.xml and
RFA.RFA-configuration-files.

Configuring Single Sign On (SSO) for
Workspace web access

Required configuration for when LSEG is the Service Provider (SP):

— Embed the Workspace Web access URL within the Identity Provider (IDP) initiated login
URL. This redirects to Workspace after a successful login.

For example:

https:\\id-abc.com\abc-
sso\eikonweb?RelayState=https:\\workspace.refinitiv.com\web

The appropriate attribute name must be used, as indicated by the IDP software, for
example, RelayState or TargetResource.
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Appendix A: Folders and files

In this section

— Packages

— Server software

— Executable files

— Digital signatures

— Registry files

— Configuration file settings
— Shortcuts

— Default folder structures
— Proxies

Packages

This document can be used by IT to create an installation package and provide
documentation for future updates to the application.

Download locations

You can download the latest version of the installation file, RefinitivWorkspace-
installer_x.xx.xx.exe, from the locations listed in the table below.

Location Link
Internet https://www.lseg.com/en/data-analytics/products/workspace/download-workspace
Private network https:\\workspace.extranet.refinitiv.biz

Executable file sizes

The installer executable size is operating system dependent:

Operating System Size (Megabits)
Microsoft Windows ~100
Apple macOS ~200

Server software

Important: DACS Permission Synchronization for Workspace is recommended — rather
than the Deployed Permissions Reconciliation Manager (DPRM) service - to prevent
misconfiguration or permission issues between the Delivery Platform (formerly RDP) and
local LSEG Real-Time Distribution System (formerly TREP).

While we recommend DACS, for information regarding the configuration of the DPRM
service, refer to )
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Versions

The following table lists the LSEG Real-Time Distribution System (formerly TREP) server
software version requirements:

LSEG Real-Time Advanced Distribution Server (formerly ADS) 3.64C or higher
LSEG Real-Time Data Access Control System 7.2 or higher

Creating an internal connection

To create a connection to the LSEG Real-Time Distribution System, you must download the
Data Dictionary from a LSEG Real-Time Connector (RTC) or LSEG Real-Time Advanced
Distribution Server (formerly ADS).

However, to do so, you must do either of the following:

—  Set *maxOutputBuffers in the LSEG Real-Time Distribution System to 5000, or

— Use the following multi-part dictionary setting*? to enable the download to be performed:
*<XYZ>*enableMultipartDictionary : True

Configuring multiple servers

Up to eight additional LSEG Real-Time Advanced Distribution Servers can be added to a
custom configuration. This is done by using the Streaming > Servers panel of the
Configuration Manager or by using the following statement:

EIKON.STREAMING.API.LOCAL .ADDITIONAL .SESSIONS. <n>
Where <n>is a number between 1 and 8.
For example:

/7‘:

Each server can have more than one URL, where each subsequent URL acts as a
failover for the specific server

:‘:/

// Main server

"EIKON.STREAMING.API.LOCAL.SESSIONS":
"[\"ws://ads01:15000/WebSocket\",\"ws://ads02:15000/WebSocket\",\"ws://ads02:
15001/WebSocket\"]1",

// -
// Additional server
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.1":

"[\"ws://example01:15000/WebSocket\",\"ws://example02:15000/WebSocket\",\"ws:
//example03:15001/WebSocket\"]"

Important: Additional servers work only if the main server connects successfully.

40 For the rwf+ws or rwf+wss protocols, the required version of Real-Time Advanced Distribution Server is 3.7.
41 The specified version requirement is for DACS Permission Synchronization only.
42 No change to the maxOutputBuffers parameter is required.
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Executable files

The core installation of Workspace has the following executables:

RefinitivWorkspace.exe LSEG Workspace (the main Workspace process)

Refinitiv-host.exe Session Sharing Chrome Extension

RWupdaterService.exe Software update installation service

Refinitiv.Workspace.BatchService.UserInteraction.exe (Optional) Batch print service 3

Setup.exe Called by the main processes to perform various sub-
processes

Workspace uses .z1p for updates. This may change in future releases, when smaller (delta)
installation packages are introduced.

Digital signatures

The executable (. exe) and dynamic link library (.d11) files are digitally signed.

From Workspace version 1.24, these files will be signed using new digital certificates. This
code signing certificate retains the same Issuer value but has different Subject and
Thumbprint values. The new certificates do not impact builds of Workspace released prior
to version 1.24.

For further information, refer to PCN208112 - LSEG Workspace 1.24 - New digital certificate.

Digital certificates for Workspace 1.24 or higher

LSEG signature

Publisher London Stock Exchange Group PLC

Subject C=GB/S=London, City of/O=London Stock Exchange Group plc/CN=London Stock
Exchange Group plc

Issuer C=GB/O=Sectigo Limited/CN=Sectigo Public Code Signing CA R36

Thumbprint 5E56E4978E9D9F19C1298C55E1E6373DFAF44A6F

Expiration Friday, April 24, 2026, 11:59:59 PM

macOS signature

Publisher REFINITIV US LLC

Subject C=US/O=REFINITIV US LLC/OU=YHNVBQZ486/CN=Developer ID Application: Refinitiv US
LLC (YHNVBQZ486)/UID=YHNVBQZ486

Issuer C=US/O=Apple Inc./OU= Apple Certification Authority/CN=Developer ID Certification
Authority

Thumbprint 148A8BC109B61AB34D6688249545B40983E3DD44

Expiration Friday, September 8, 2028, 03:17:30 GMT

Digital certificates for Workspace 1.23 or earlier

All Desktop and native apps files stamped with the previous or expired certificates are not
affected by this change and will remain validly signed without any time limit.

43 The Batch Print service is an optional download, used to print or save documents from the search results grid.
The service can be downloaded using the following URL:
https:\\cdn.refinitiv.com\public\packages\batchsaveinstall\R efinitivWorkspaceBatchService.msi
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Refinitiv signatures

Publisher
Subject

Issuer

Publisher#*
Subject
Issuer
Thumbprint
Expiration

Microsoft signature

Publisher
Subject
Issuer

macOS signature

Publisher
Subject

Issuer

Thumbprint
Expiration
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REFINITIV US LLC

C=US/PostalCode=10036/S=New York/L=New York/STREET=3 Times Square/O=REFINITIV
US LLC/CN=REFINITIV US LLC

C=GB/S=Greater Manchester/L=Salford/O=Sectigo Limited/CN=Sectigo RSA Code Signing
CA

REFINITIV US LLC

C=US/S=New York/O=REFINITIV US LLC/CN=REFINITIV US LLC
C=GB/O=Sectigo Limited/CN=Sectigo Public Code Signing CA R36
faeb75e9e11605257a0c9b32c8c1f4aa61245276

Friday, November 24, 2023, 11:59:59 PM

Microsoft Corporation
C=US/S=Washington/L=Redmond/O=Microsoft Corporation/CN=Microsoft Corporation

C=US/S=Washington/L=Redmond/O=Microsoft Corporation/CN=Microsoft Code Signing PCA
2010

REFINITIV US LLC

C=US/O=REFINITIV US LLC/OU=YHNVBQZ486/CN=Developer ID Application: Refinitiv US
LLC (YHNVBQZ486)/UID=YHNVBQZ486

C=US/O=Apple Inc./OU= Apple Certification Authority/CN=Developer ID Certification
Authority

B69FD35BFDOD7FFE877DCF570A4EFC7D4ESADCFA

Wednesday, October 16, 2024, 14:47:34 GMT

Registry files

Installation mode
User

Machine with an auto-
update per user

Machine with auto-update
service or no auto-updates

Description Registry key User

The registry is deployed only once, at HKCU*® Current user
installation time

The registry is deployed multiple times, as it HKCU, HKLM Every user (Separate
depends on Active Setup user profile)

The registry is deployed only once, at HKLM?6 Every user

installation time.

Configuration file settings

The following settings are customizable in your . json configuration file.

Setting Customization

EIKON.STREAMING.API.LOCAL .ALLOWHOSTEDFALLBACK Defining this setting as £a 1 se, indicates that you do not want

EIKON.STREAMING.API.LOCAL.DACS.APPLICATIONID

CLIENTSSO_URL.ENABLED
CLIENTSSO_URL

Workspace to fall back to the Common Platform hosted streaming
servers. In this case, if the connection to all configured local server
URLSs fails, Workspace is unable to retrieve streaming data.

By default, Workspace systematically attempts to connect to the
Common Platform hosted streaming servers, if no local connection
can be made.

This setting allows you to customize the DACS application ID, for
Workspace it is 56 by default.

Support Client SSO service to allow the user to use company
credentials to login.

44 For further information, refer to PCN 13469

4 HKEY_CURRENT_USER
4 HKEY_LOCAL_MACHINE
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Shortcuts

There are two shortcuts created under the Refinitiv folder, found under the Start menu:
— Refinitiv Workspace
— Refinitiv Workspace - Excel

Default folder structures

The following table contains the default folder structures for User and Machine installations,
and includes the location under which the structures are created:

Service Location Structure
User installation
n/a %LocalAppData% —Refinitiv for Office
| L—1.20.68
j——config
| L_addin.config.json
| —Office_x64
| | L—refinitiv-shim.d11
L Office_x86

L—refinitiv-shim.d11
—Refinitiv Workspace

| |— com.refinitiv.workspace.sessionsharing.json
| |— install-settings.json

|— installInfo.json

|— Refinitiv-host.exe

— RefinitivWorkspace.exe

|
| — Tocales
|
|

— resources
L— swiftshader

—Refinitiv Workspace Install Logs
—Refinitiv Workspace Logs
——Refinitiv Workspace.versions
| L—1.21.344
L__Refinitiv Workspace.ToInstall

| —RFYWWindows_Core_1_21 276.zip

L__Extract

%AppData% L Refinitiv Workspace
— Local State
L— Cache

Machine installation

With auto- %ProgramFiles% —Refinitiv for Office
update service L—1.20.68

|
| j——config
| | L—addin.config.json
| —Office_x64
| L_refinitiv-shim.d11
| L 0Office_x86
| L—refinitiv-shim.d11
L_—Refinitiv Workspace
—install-settings.json
——Refinitiviorkspace. exe
L—1.21.344
———com. refinitiv.workspace.sessionsharing.json
—instal1Info.json
—Refinitiv-host.exe
—-RefinitivWorkspace. exe
—RWupdaterService.exe

—Tocales
j—resources

L_swiftshader
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Structure

—Refinitiv Workspace

| F—pmInstallInfo.json

| L—userInfo.json

—Refinitiv Workspace Install Logs

—Refinitiv Workspace.versions

|  L—1.21.344

L Refinitiv Workspace.ToInstall
| —RFVWWindows_Core_1_21_276.zip
L_Extract

L—Refinitiv Workspace Logs

L_Refinitiv Workspace
—Local State
L—Cache

—Refinitiv for Office
| L—1.20.68
| j——config
| | L—addin.config.json
| —Office_x64
| | L—refinitiv-shim.d11
| L Office_x86
| L—refinitiv-shim.d11
L__Refinitiv Workspace
——com.refinitiv.workspace.sessionsharing.json
—install-settings.json
—installInfo.json
—Refinitiv-host.exe
—RefinitivWorkspace.exe
—Tocales
—resources
L—swiftshader

—Refinitiv Workspace

| k—pmInstallInfo.json

| L—userInfo.json

|

L Refinitiv Workspace Install Logs

L Refinitiv Workspace.versions
L—1.21.344

—Refinitiv for Office

| L—1.20.68

| ——config

| | L—addin.config.json

| —Office_x64

| | L—refinitiv-shim.d11

| L 0Office_x86

| L—refinitiv-shim.d11

—Refinitiv Workspace

| ——com. refinitiv.workspace.sessionsharing.json

| |—install-settings.json

| |—installInfo.json

| |—Refinitiv-host.exe

| —RefinitivWorkspace.exe

—Tocales

—resources
—app.asar
—deployment.asar

——package.zip
——REFINITIVEXCEL.ico

|
|
I
| —REFINITIVMESSENGER.ico
|
|

——REFINITIVWORKSPACE.1ico
—versionInfo.json
L__app.asar.unpacked

L—swiftshader

—Refinitiv Workspace Logs

L Refinitiv Workspace.ToInstall
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Service Location Structure
| —RFVWWindows_Core_1_21 276.zip
L_FExtract
%AppData%\Refinitiv L Refinitiv Workspace
—Local State
L—Cache

%Temp% L Refinitiv Workspace Uninstall Logs

Without auto- %ProgramFiles%\Refinitiv —Refinitiv for Office
update service | L—1.20.68

| ——config

| | L—addin.config.json

| —Office_x64

| | L—refinitiv-shim.d11

| L—Office_x86

| L—refinitiv-shim.d11

L_Refinitiv Workspace
——com. refinitiv.workspace.sessionsharing.json
—install-settings.json
—installInfo.json
——Refinitiv-host.exe
——RefinitivWorkspace.exe
—Tocales
—resources
L—swiftshader

%ProgramData%\Refinitiv —Refinitiv Workspace

| F—pmInstallInfo.json

| L—userInfo.json

—Refinitiv Workspace Install Logs

L_Refinitiv Workspace.versions

L—1.21.344
%LocalAppData%\Refinitiv L Refinitiv Workspace Logs
%AppData%\Refinitiv L Refinitiv Workspace

—Local State

L—Cache
%temp% L—Refinitiv Workspace Uninstall Logs

Proxies

Qualified Proxy

Workspace is qualified with the following authenticated proxy:

Proxy Authentication Method

Squid 2.7 — No authentication
— Basic
— Digest
— NTLM
— Kerberos
Squid 3.5.28 — Basic
— Digest

HTTP/1.1 (or above) Compliant Proxy

Workspace requires HTTP/1.1. Workspace can attempt to use HTTP/2 but falls back to
HTTP 1.1 if it is not viable.
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It is vital that you use an HTTP/1.1+ Compliant Proxy to have the best connection between
the Workspace key station and the LSEG Platform on the head end.

Important: The Streaming Service requires a keep alive or persistent connection, which is
supported in the HTTP/1.1 specification.
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. . . -
Appendix B: Software information

and support

In this section

— Documentation locations

— Export control classification

— Hosted connection item limits
— About LSEG Workspace dialog
— Data dictionary support

— Local mode support

Documentation locations

Workspace technical content can generally be found in two locations:

— The documentation section of the LSEG Workspace page. These documents are
searchable using all popular search engines (such as Google or Bing).

— Under the Workspace section of MyAccount (formerly MyRefinitiv), the authenticated
website.

Where documents are to be found in other locations, these are provided in the table below:

Documentation Location(s)

Workspace Administration Panel A description of the functions of the Workspace Administration Panel can be found
Configuration in the Configuration Guide.

Workspace System Requirements The system requirements documentation can be found in the System

Requirements document.
LSEG Real-Time Data Access Control ~ The DACS permission synchronization requirements can be found in the DACS

System (formerly DACS)*” Permission Synchronization Configuration Guide, under the DACS section of the
authenticated website.

LSEG Real-Time Advanced An overview of the ADS WebSocket connection configuration can be found in the

Distribution Server (formerly ADS) ADS Software Installation Manual, under the Advanced Distribution Server (ADS)
section of the authenticated website.

LSEG Real-Time Advanced Content covering the installation and configuration of the LSEG Real-Time

Distribution Hub (formerly ADH) Advanced Distribution Hub can be found in the Advanced Distribution Hub section
of the authenticated website.

Financial Community Network (FCN) For further information about FCN and Delivery Direct, see the Private Network

and Delivery Direct Overview section of the authenticated website.

Chrome Extension For further information about the Google Chrome extension, see the Chrome
Extension Installation Guide.

Release Notes A summary of the features in the latest release of Workspace can be found in the
Release Notes document.

Service Description The Workspace Service Description document can be found in the Service
Description document.

Workspace Vendor Subservice A list of the Products, Exchanges, and Specialist Data definitions can be found in

Definitions the Vendor subservice definitions document. These are managed using the LSEG
Real-Time Data Access Control System (DACS).

Technical Roadmap A tabular summary of known significant changes to upcoming releases of

Workspace can be found in the Technical roadmap document.

47 DACS Permission Synchronization for Workspace is recommended — rather than the DPRM service - to prevent
misconfiguration or permission issues between the Delivery Platform (formerly RDP) and local LSEG Real-Time Distribution
System (formerly TREP).

While we recommend DACS, for information regarding the configuration of the DPRM service, refer to Appendix E: Settings.
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Export control classification

The following table contains export control classification details for Workspace:

Program Name
ICOS Reference
Program Version
Sub-Products

ECCN (United States)

ECCN (European Union)
Refinitiv Export Code
Export Note

US Commerce, BIS CCATS number

Hosted connection item limits

For the deployed desktop hosted connection, the Item limit is 2500. This can be extended to

Refinitiv Workspace

6420

1.x

6413 for Windows & 6414 for macOS

EAR99

None

NL

This export code means ‘Not Licensable’ and is applied to items that can be
exported ‘no license required’, under both EU and US regulations. Exports of
NL items can be made to all countries except embargoed countries (Iran,
Syria, North Korea, Cuba, or Crimea).

self-classified

5000, with a fee-liable Product Line Item (PLI) add-on.
Once the limit is reached, a message is displayed in the About LSEG Workspace >

Streaming panel.

About LSEG Workspace dialog

The About LSEG Workspace dialog box provides information about the viewed Workspace

installation and
environment.

To open the About
LSEG Workspace
dialog, In Workspace:

— Click Help > About
Refinitiv
Workspace

The dialog box divides

information over five

panels:

— System Status
contains
Workspace version
and variant
information,
together with
service connection
details and an

System Status
Streaming
User Details

Data API Proxy CONNECTION

Services & Apps Connected via:
Authentication Mode:
Active Site:
Heartbeat Status:

Real-Time Status:

RDP Gateway Status:

Real-Time Connectivity:

DPRM Status:

SYSTEM
Operating System:
CPU:

CPU Speed:

RAM:

Copy to Clipboard

About LSEG Workspace

LSEG
Workspace

VERSION: DESKTOP 1.23.257
Supported Versions

Copyright © 2023 LSEG and/or its affiliates. All rights reserved.

Internet

Legacy

Primary - EMEA1
OK

=5 You are
OK
Hosted

sfully connected to LSE

unsupported

Microsoft Windows 10 Pro (10.0.19044)
Intel Core™ i7-9850H (x12)

2.6 GHz

32.0 GB (31.8 GB usable)

LSEG Workspace
is up to date

overview of the computer on which this iteration of Workspace is running.
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— Streaming contains information about real-time data sources, including the primary feed
used, RICs used*® (subscriptions), and any other feeds provided through a local LSEG
Real-Time Distribution System.

— User Details contains information about the currently logged in user, including their email
address, their user unique identifier (UUID), job role, and location information.

— Along with the proxy URL and version, the Data API Proxy panel also contains
information about the status of the proxy, indicating whether it is available for external
connections.

— Services & Apps contains version information about services and apps that have been
made available to the user.

Data dictionary support

Access to a Data Dictionary is only supported from a LSEG Real-Time Advanced Distribution
Server (formerly ADS).

Local mode support

The Local Mode feature, as found in Eikon, is not supported.

48 See the Hosted connection item limits section.
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Appendix C: Command line
statements

In this section

Installation statements

Uninstallation statements

Configuration Manager parameters

Workspace executable statements

Installation statements

— Performing an installation

The table below list command line statements that can be using your Single Sign On

used to install Workspace: URE
Installation mode Command
Base commands
User % RefinitivWorkspace-installer_x.xx.xx.exe --user
Machine RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-peruser
Machine without Auto-Update RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no
Machine with Update Service RefinitivWorkspace-installer_x.xx.xx.exe —-machine-autoupdate-service
SSO RefinitivWorkspace-installer_x.xx.xx.exe --client-sso=<client SSO URL>
Installation help page RefinitivWorkspace-installer_x.xx.xx.exe --help
Run Messenger onIy RefinitivWorkspace-installer_x.x .exe --messengeronly
Additional parameter --sharedconfig="<file path>"
Failover --sharedconfig="<file path-1>";"<file path-2>";"<file path-3>"

Uninstallation statement

The table below list command line statements that can be used to uninstall Workspace:

RefinitivWorkspace.exe --uninstall

Configuration Manager parameters

The table below list command line statements that can be used to configure Workspace:

Installation mode Command

User "<Instal1Dir>\Refinitiv\Refinitiv Workspace\RefinitiviWorkspace.exe"
--config-manager
Machine or Hot-Desking "<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitiviWorkspace.exe"

--config-manager --machine

4 This is the default method of installing Workspace. As such, the —-user parameter is not a requirement.

%0 For example, RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-peruser --
sharedconfig="<f71e path>"is the command line for a machine installation with a shared configuration.

51 The content of the file(s), identified by the --sharedconfig parameter, could change from version-to-version. So, refer to
the appropriate documentation for amendments to this parameter when there is a new release.
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Workspace executable statements

There are various parameters you can add to the Workspace executable, located in the
%ProgramFiles%\Refinitiv\Refinitiv Workspace\<version>\ folder.

The command line structure is:
RefinitivWorkspace.exe <Parameter>

For example:

RefinitiviWorkspace.exe —-connection=internet
The following parameters are available:

--clearCache Clear the Electron cache of Workspace
--clearlLogs Clear the logs folder of Workspace
--clearRememberMe Delete the automatic login cookie
--client-sso=<url> Set the URL for your SSO
-—dumpApps Dump available Apps of Workspace into the logs folder
—-dumpConfig Dump the configuration of Workspace into the logs folder
—-excel Start Excel with the Workspace ribbon add-in
--log-Tlevel=<level> Set the level of detail for log files, where <level>is:

— error

— warning

— information

— verbose

— debug
--resetCache Reset the product cache of Workspace to its default state
--systemtest Run the embedded System Test 52
--uninstall Uninstall Workspace

--update-office-registry=<value> Used to update the office registry key, where <value> is either HKLM or HKCU.
For further information, see Excel add-in loading issues.

—--upload-Togs Upload log files

--version Show the version of Workspace 52

--versions Display the version of underlying components of Workspace, for example:
--versions=electron, node (or simply --versions)

--nofile Start system tray icon only

Installer command line statements

Currently, only the following command line statement is available, which enables Workspace
to run at a higher processing priority:

RefinitivWorkspace-installer_x.xx.xx.exe --run-above-normal-priority

52 For further information regarding the System Test applications, refer to the Workspace System Test Guide.
53 On macOS, for this command to work as intended, go to the /Applications/Refinitiv
Workspace.app/Contents/MacOS folder and run the command, ./Refinitiviorkspace --args --version.
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Appendix D: Automatic update
workflow

The content in this appendix applies to the following installation types:
- --user

— --machine-autoupdate-peruser>*

— --machine-autoupdate-service

The --machine-autoupdate-no installation mode is not discussed, as automatic update
functionality is disabled for that mode.

Device and installation registration

1. Login into Workspace

2. During the first minute after login, Refinitiviorkspace.exe retrieves installationGUID
from installinfo.json.

— IfinstallationGUID is not found in installinfo.json, itis created using guid.json®®
— Ifinstallinfo.json does not exist, it is created automatically

— Depending on the installation method, installinfo.json is in one of the following

locations:
Method Location
User C:\Users\%UsernameX%\AppData\Roaming\Refinitiv\Refinitiv Workspace\
Machine with auto update per user <install path>\Refinitiv\Refinitiv Workspace\
Machine with auto update service %programdata%\Refinitiv\Refinitiv Workspace\

3. RefinitivWorkspace.exe sends arequest to Desktop Deployment Portal to do the
following:

a. Check whether the device is registered on Desktop Deployment Portal and, if not, add
the new device

b. Add alogin history record

Checking new version availability

Randomly, between 5-60 minutes after login, Refinitiviorkspace.exe checks ®¢ the
availability of the new target version for the current user. Version checks are then scheduled
daily, at 00:<randomMinutes>.

4. Checks the new version with Admin Panel®’
5. Checks the new version with Desktop Deployment Portal

5 For --machine-autoupdate-peruser mode only: To update the master installation automatically (bulk autoupdate), the
administrator should get the latest version and reinstall Workspace. All users, that have a lower version than the master
installation, are updated to the new version of master installation automatically, with the active setup, once they log off from
Windows, and log in again.

% Guid.json is located under C:\Users\%Username%\AppData\Roaming\Refinitiv\Refinitiv Workspace\

6 This check can also be triggered by opening the About Box.

57 For further information, see the Administration Panel Configuration Guide.
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Changing the update time

To change update time after login, use the command --checkupdateTime=<n>, where:
— --checkupdateTime=0 — Checks for a new version instantly after login
— No parameter set — Checks for a new version randomly between 5-60 minutes after login

Setting up a custom scheduler

To set up a custom scheduler to check for new versions, use the command:
--autocheckupdatetime=<a> <b> <c> <d> <e>
Where:

<a> Day of week (0 — 7, where 7 is Sunday). You can also use names, that is,
Monday, and so on.

<b> Month (1 - 12)

<c> Day of month (1 - 31)
<d> Hour (0 - 23)

<e> Minute (0 - 59)

For example, for an update check to be performed every Sunday, at 5:30 PM, use the
command:

--autocheckupdatetime=7 * * 17 30
If a new version is detected see the next steps.

Downloading a version and preparing for
upgrade

1. Workspace receives the target version information (including URL) and automatically
downloads the zipped package.

URL https:\\cdn. refinitiv.net\public\packages\RFYWWindows\RFVWWindows_Core
_X_XX_XXX.Z1p

Installation type Download location

--user %AppData%\Local\Refinitiv\Refinitiv Workspace.ToInstall

--machine-autoupdate-peruser

--machine-autoupdate-service  %programdata%\Refinitiv\Refinitiv Workspace\Refinitiv
Workspace.ToInstall

2. Workspace extracts the files from the zipped file to a newly created Extract folder

Calling process RefinitivWorkspace.exe
Unzip tool yauzl node_module %8
Extract location <Download Tocation>\Extract

%8 https:\\Wwww.npmijs.com\package\yauzl
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Checking new package with Desktop
Deployment Portal

1. Checks whether the content in the Extract\checkUpdateInfo.json matches the
content received from the Desktop Deployment Portal (by checking the file hash code):

If... Then...
Yes Skip downloading the new package and wait for the upgrade initiation
No Delete the downloaded package and Extract folder

2. Download the new package, with the updated Extract\CheckUpdateInfo.json
content (see Downloading a version and preparing for upgrade)

Initiating an update

1. The persons required to perform this step depend on the installation type:

Installation type Performed by
--user The user of the machine where Workspace was installed

--machine-autoupdate-peruser Each Workspace user on the machine where the application was installed
--machine-autoupdate-service Any user of the machine(s) where Workspace was installed

— To begin the upgrade, do one of the following:

— Select the Help menu, choose About Refinitiv Workspace, and click the Upgrade
now button.
— Select the Refinitiv Workspace menu and choose:

— Sign Out, or
— Exit Refinitiv Workspace

2. RefinitivWorkspace.exe runs an Extract\setup.exe command, with arguments
based on setupArgs, defined in CheckUpdateInfo.json.

Installation type Example command
--user setup.exe --update --rerun --silent --forceInstall --

hi calledByCheckupdate --execute=RefinitivWorkspace.exe --applLocation=
--machine-autoupdate-peruser C:\\Users\\%Username%\\AppData \\Local\\Refinitiv\Refinitiv Workspace

—--machine-autoupdate-service setup.exe --update --rerun --silent --forcelnstall --
calledByCheckupdate --execute=RefinitivWorkspace.exe --
applLocation=C:\\Program Files\\Refinitiv\Refinitiv
Workspace\\1.19.447

Upgrade workflow

The following actions are performed by Extract\Setup.exe:
1. Waits for several seconds until Refinitiviorkspace.exe is terminated®®

2. Performs a backup of installation folders, based on the information in the files section
of InstallInfo.json

5 |f Refinitiviorkspace.exe has not been terminated, Setup.exe force-kills the process.
For --machine-autoupdate-service mode: Only the instigating user is required to terminate their Workspace session.
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a. --machine-autoupdate-service only: Checks whether Workspace is in use by
another user:

If... Then...

Yes Go to step 2.c.
No Go to step 2.b.

b. Backs up the Workspace installation folder:
--user

. Refinitiv Workspace <install_path>\Refinitiv Workspace.Backup
--machine-autoupdate-peruser

<install_path>\Refinitiv\Refinitiv

--machine-autoupdate-service  Workspace <Version> .
pd pa Workspace\<Version>.Backup

c. --machine-autoupdate-service mode only: Checks whether Microsoft Office is in
use by another user on the same machine:

If... Then...

Yes Go to step 2.e.
No Go to step 2.d.

o

Backs up the Refinitiv for Office installation folder:

Installation type Installation folder Backup location

--user .
--machine-autoupdate- g_?;: 2::1 v for <install_path>\Refinitiv for Office.Backup
peruser

--machine-autoupdate- . , install_path>\Refinitiv for
. £ Office <Version> < X P . \
service Office\<Version>.Backup

e. --machine-autoupdate-service mode only: Performs a backup of the Update
Service installation folder:

Installation type Installation folder Backup location

--machine-autoupdate- Update Service <install_path>\Refinitiv Workspace Update
service <Version> Service\<Version>.Backup

3. Backs up the shortcuts folder, based on the information in the shortcutsFolder
section of InstallInfo. json:
--user %appdata%\Refinitiv\Refinitiv Workspace\Backup\<randomname>-

--machine-autoupdate-peruser backupShortecut\

--machine-autoupdate-service %programdata%\Refinitiv\Refinitiv Workspace\Backup\<randomname>-
backupShortcut\

4. Creates new folders and installs files:

Installation type Workspace location Office location Update Service location

--user . .. . .
i <install_path>\Refinit <install_path>\Refin na
—fradmne- iv Workspace itiv for Office
autoupdate-peruser
e <install_path>\Refinit <i rjsta'l 1_path>\Refin <install_path>\Refinitiv
autoupdate-service iv Workspace\<Version> Ty o Lol Ugskize
Office\<Version> Service\<Version>

5. Installs shortcuts:

Installation Type File location

--user %AppData%\Microsoft\Windows\Start Menu\Programs\Refinitiv
--machine-autoupdate-peruser —  %AppData%\Microsoft\Windows\Start Menu\Programs\Refinitiv
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Installation Type File location

— %ProgramData%\Microsoft\Windows\Start Menu\Programs\Refinitiv
--machine-autoupdate-service %ProgramData%\Microsoft\Windows\Start Menu\Programs\Refinitiv

o

Installs Add Remove Programs (ARP) registry entries for Workspace

N

Checks whether Workspace was installed with -messengeronly parameter:

If...
Yes Go to step 9
No Goto step 8

©

Installs Office Registry and Office Add-ins

©

Creates instal |-settings. json, containing settings for Microsoft Office, providing the
location for Workspace and Office add-ins:

--user <install_path>\Refinitiv\Refinitiv Workspace\
--machine-autoupdate-peruser

--machine-autoupdate-service <install_path>\Refinitiv\Refinitiv Workspace\<version>

10. Creates com. refinitiv.workspace.sessionsharing.json, providing Chrome
extension settings and the location of the Refinitiv-host.exe file:

--user <install_path>\Refinitiv\Refinitiv Workspace\
--machine-autoupdate-peruser
--machine-autoupdate-service <install_path>\Refinitiv\Refinitiv Workspace\<version>

11. Checks whether the installation was completed successfully:

If... Then...
Yes Removes backup folders ©°
No Removes all newly installed files and restores backup folders.

Ends the installation with an error message.

12. Creates InstallInfo.json, in a mode-specific location, and writes new installation
information, such as installation paths, shortcut paths, and so on:

--user <install_path>\Refinitiv\Refinitiv Workspace\
--machine-autoupdate-peruser
--machine-autoupdate-service <install_path>\Refinitiv\Refinitiv Workspace\<version>

13. If the update was triggered by signing out, it relaunches Workspace with —--startApp

80 For the machine-autoupdate-service only: If Workspace is in use at the time of update, the previous <Version>folders

under Refinitiv Workspace and Refinitiv for Office are preserved. Once all users have logged out of their devices
and logged in again, access to the new Workspace version is facilitated using Active Setup.
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Appendix E: Settings

In this section

— Networking

— Microsoft Office settings

— Security

— Enabling the DPRM service

Networking

Ports

Workspace uses the following connections:
AP 6t Connection Port 2
Desktop Data API http:\\Tocalhost:9000\api\ 9000
Side by Side AP| 63 http:\\localhost:9000\sxs\ 9000
Refinitiv Workspace Bus http:\\localhost:49152\ 49152

Communication protocols

Protocol Port Number Workspace Services Required For
TCP 1024+ — 443 LSEG Workspace Administration Services
1024+ «— 443 Platform View Service

Search & Navigation Service
Time Series Service
Workspace Messenger Service,
Trading Service

Update Service

Thomson Reuters Remote Support (TRRS)
Datastream Service

Newscasts (internet only)

FXall

Flextrade Spark

Real-Time Data

TCP 1024+ — 15000 Real-Time Data LSEG Real-Time Advanced Distribution Server (formerly ADS)
1024+ «— 15000
TCP\UDP 1024+ — 53 DNS Server Domain Name Resolution from Domain Name Server
1024+ «— 53
Services

This section summarizes the services and features related to connectivity and provides links
to further information.

51 You can find further information regarding APIs on the Developer Community website.

9000 and 49152 are internal ports. If the port is already in use, Workspace increments until a free port number is found:
— for Desktop Data and Side by Side, from 9000, and

— for Workspace Bus, from 49152

For further information, see Workspace Web Side by Side API on the Developer Community website.

62

63
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Financial Community Network and Delivery Direct

To access new AWS service endpoints, customers using a private network must whitelist the
following new IP addresses, which impact Delivery Direct, FCN, and CMC users:

—  159.43.192.0/23 (AMERS)
~  159.43.200.0/23 (EMEA)
—  159.43.208.0/23 (APAC)

For further information about Finance Community Network (FCN) and Delivery Direct, see
the Private Network Overview section of MyAccount (formerly MyRefinitiv), containing the
following documents:

— Customer Connectivity DNS Migration Guide
— FCN Customer Connectivity Guide

Internet

LSEG will not divulge IP address information under any circumstances. Doing so prevents us
from changing IP addresses, as and when needed, without a notification period. These IP
addresses may not always be under our direct control.

Transport Layer Security protocol

From 01 June 2023, to continue to use LSEG Real- | & intemetproperties 7 X
Time services, you must ensure that use of TLS
version 1.2 is enabled for all Workspace users.

General Security Privacy Content Connections Programs Advanced

Settings

TO enable TLS 1 2 [] Enable Enhanced Protected Mode™® -
Enable Integrated Windows Authentication™®
. . Enable native XMLHTTP support
1 . I n WI ndOWS, CIICk Start Enable Windows Defenderp;martiaeen
[] send Do Mot Track requests to sites you visit in Internet E
2. Open the Control Panel app and choose O usesst 30
[ useTs 1.0
Network and Internet O usems 11
UseTLS 1.2
3. Inthe Network and Internet panel, choose [ use TS 1.3 (expermental)
. Warn about certificate address mismatch™®
I ntel‘n et OptIO ns [1 warn if changing between secure and not secure mode
. . Warn if POST submittal is redirected to a zone that does n
4. Inthe Internet Properties dialog, shown . -
ODDOS |te, Se|eCt the Ad van Ced tab *Takes effect after you restart your computer

Restore advanced settings

5. Scroll to the Security section (at the end of the Reset Intemet xgloer setings
Sett'ngs |ISt) a.nd Se|eCt Use TLS 1.2 Resets Internet Explorer's settings to their default Reset...

condition.

For further |nf0|’mat|0n, r‘efer to PCN205244-Change ‘fou should only use this if your browser is in an unusable state.
in supported TLS protocols for Eikon and

Workspace.
Cancel Apply

Web hosted services

The following services and features are accessed through the Internet and not reached
through a private network:

MyRefinitiv (my.refinitiv.com) The authenticated documentation repository.
Contact Us For raising questions, issues, and other topics.

Sends data to the LSEG support platform. This is in case a user has a session
Desktop crash dump upload utility crash. The crash data is sent from the user session to Refinitiv, so we can

investigate the crash.

Where feedback / support issues are logged, and you can establish a chat
dialogue with an agent.

GetSupport or interactive Chat
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Messenger Traffic All traffic will be over internet, by default. ¢
Portal SDK starter kit Software Development Kit (SDK) is a toolkit that you can use to interact with the
(cdn.refinitiv.com) app and our platform. This is hosted on CloudFront.

This is accessed from an external web site, either by the user going to the Google

Chrome Extension store, or through enterprise set-up.

Content filtering domains

You need to whitelist the domains for content that can be accessed through Workspace.

Important: Third Party apps in Workspace may require access to specific domains. For

information about specific access requirements, it is advisable to contact the app
developer directly.

Example domain list

The following list of domains is not exhaustive and is for illustrative purposes only.

® Many of the domains listed in the table below are wildcard values, where a subdomain
may prepend and/or append the listed domain.

DNS Workspace services
autex.com

autexnow.com
authenticator.pingone.com
idpxny13m.pingidentity.com

Autex

Multi-factor Ping Authenticator app

bit.Tly

reut.rs Bit.ly Integration Information
tmsnrt.rs

trmcs-documents.s3.amazonaws .com Central Bank Polls
session.rservices.com Contribution address, News documents
cnbc.com

ft.com Miscellaneous external content
moodys . com

googleapis.com Google

chrome.google.com Workspace Chrome Extension

virtualearth.net

. Interactive Map
thomsonreuters.wdtinc.com

Tipperweb.com Lipper Market Insight
Toanconnector.com Loan Connector
Toanpricing.com Loan Pricing

depth.finance Market Depth

cdn.mathjax.org MathJax JavaScript display engine

storage.tr.191.it

thomsonone. com News Documents
ws.platts.com

reuters.com

breakingviews.com

refinitiv.com

refinitiv.net

refinitiv.biz LSEG
thomsonreuters.com

thomsonreuters.net

News URL link

64 This is not the case when private line connectivity is enabled for Workspace Messenger. For further information, see
Appendix E: Workspace Messenger standalone.
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DNS Workspace services
thomsonreuters.biz

globalrelay.com Workspace Messenger Compliance

salesforce.com T

. Refinitiv Migration Tools
webtrendslive.com

kaltura.com
reuters.tv Newscasts (formerly Reuters Insider)

vmnd. tv
cxvid-Tivecapture.s3.amazonaws.com Newscasts (formerly Reuters Insider): Recording Video and Images

thomson.112.207.net Newscasts (formerly Reuters Insider): Analytics and user interaction reporting

gstatic.com

apis.google.com
bv-predictions2021.com
cloudfront.net
google-analytics.com
googletagservices.com
product.datastream.com
themes.googleusercontent.com
trust.org
views.rkd.reured.com

Reuters Interactive graphics

bing.com Search engine

media-server.com Street Event content

comodo . com TLS/SSL Client Certificate (HTTPS)
tradeweb.com Tradeweb

fxall.com Trading Service

pbs . twimg.com

. Twitter integration
twitter.com

wom. finance Wealth Order Management
awsglobalaccelerator.com

avatars.stocktwits.com Social Media Monitor

;Tgéﬁ;?zé;om LSEG Training
salesforceliveagent.com Support

oneaccess.io OneAccess

dtn.com Weather layers in InteractiveMap app

Trusted root certification

You can download and verify the COMODO certificate from the appropriate location, defined
in the table below:

Internet https:\\cipher-test.refinitiv.com\
Private network https:\\cipher-test.extranet.refinitiv.biz\

Certificate details:

Issued by CN O ©
COMODO COMODO RSA Cetrtification COMODO RSA Certification COMODO CA Limited GB
Authority Authority
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Workspace for Excel VSTO add-in

For the Microsoft Excel Visual Studio Tools for Office (VSTO) add-in, Workspace installs a
single DLL file under the Windows operating system, refinitiv-shim.d11. This supports
the core features of the Refinitiv Workspace - Excel (Workspace ribbon) add-in.

MS Office File location

<Install_path>\Refinitiv\Refinitiv for Office\x.x.x\Office_x86
<Install_path>\Refinitiv\Refinitiv for Office\x.x.x\Office_x64

32-bit
64-bit

There is no linking, presentation tools, or deal analytics package.

Workspace add-in

The Refinitiv Workspace - Excel (Workspace ribbon) add-in changes are listed in the table

below:

Version Add-ins

1.22
121

1.20
1.19
1.18
1.17
1.16

1.15
1.14
1.13
1.12

No changes
=RDP.FxSwpToSwp()
=RDP.FxDepToSwp()
=RDP.FxSwpToDep()
=RDP.FxSpot()
=RDP.FxInfo()
=RDP.FxZcToFra()
=RDP.DateAdjToWD()
=RDP.DateCountPeriods()
=RDP.DateFindDate()
=RDP.DatelsWD()
=RDP.DateLastWD()
=RDP.DateListHolidays()
=RDP.Adinterp()

No changes

No changes

No changes

No changes
=RDP.Publish()
=RtContribute()®®
=RDP.PublishChain()
=RtContributeChain()
=DSCHART()

No changes

No changes

No changes
=TRAggregate()
=RDP.Aggregate()
=RDP.Analytics()
=RDP.Data()
=RDP.HistoricalPricing()
=RDP.Price()
=RDP.Today()
=RDP.Now()
=RtToday()

=RtNow()

Refinitiv.EmbeddedApplication (financial chart)

=DSGRID()

=Thomson.Reuters.AFOSpreadSheetFormulas.DSGRID()

=RDP.Search()

65

See Contributions (RtContribute) in the Appendix J: Known issues section.

LSEG Workspace Installation and Configuration Guide
Document Version 124.08



Appendix E: Settings 53

Version Add-ins

1.8 =RHistory()
=RtGet()
=TR()

Customer managed over Internet

Customer managed over Internet mode is a sub deployment, where Workspace connects the
real time data on a user's own local LSEG Real-Time Distribution System (formerly TREP)
infrastructure, while other content is sourced from the Delivery Platform (formerly RDP),
through the Internet.

To configure this:
8 Connection Type @ This s the default option and
1. In Workspace, open Configuration © hiemety
Manager. —— "y
2. Inthe Network panel, under B P R P S

Connection Type, select Internet.

3. Inthe Streaming panel, under
Streaming Data Retrieval, select
From alocal LSEG Real-Time
Advanced Distribution Server (ADS).

4. This opens three separate panels —

Streaming Conflation

Servers, Feeds, and DACS —where il o et R e I e

you can add your server and feed
information.

Security

FIPS

Workspace is not supported in a 140 series Federal Information Processing Standards
(FIPS) environment.

User Agent

A User Agent is an application that retrieves and presents Web content for users or is
implemented using Web technologies.

Workspace identifies connections to the ADS User Agent. For example, this could contain
the following string and version:

RFV-Workspace\<version>
Where the <version>is updated to match the Workspace executable version.

Enabling the DPRM service

Important: In Workspace 1.23, there is a with the DPRM service that affects

a small minority of installations. This has been fixed in Workspace 1.24.

For those Workspace desktop customers who want to use the optional DPRM service in their
local LSEG Real-Time Distribution System, the settings in the following table can be added
to the <override_settings>.7json file.
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Setting Description

EIKON.STREAMING.API.LOCAL .DACS.DPRM. PORT ©6 This allows you to specify the port to use to retrieve the entittements
used for DPRM.
In general, the port should be set to either of the following modes®’:
— 8261 - Permission proxy mode, or
— 8302 - Permission service mode®®
EIKON.STREAMING.API.LOCAL .DACS.DPRM.INTERVAL This allows you to set the interval, in milliseconds, between each
reconciliation of DACS entitlements with the DPRM service.
Default value: 86400000 (24 hours).

ETKON.STREAMING.API.LOCAL .DACS.DPRM.DELAY This allows you to set the delay, in milliseconds, between
Workspace initialization after login and the reconciliation of DACS
entitlements with the DPRM service.

Default value: 60000 (60 seconds).

EIKON.STREAMING.API.LOCAL .DACS.DPRM. SERVERS This parameter is used when running permission service mode only.
This allows you to specify a list of servers to use for DPRM and
should be set for permission service mode only (port 8302).%°
This setting is defined as a JSON-encoded array of permission
service hostnames. For example:
"[\"dacs01\",\"dacs02\",\"dacs03\"]"

DPRM settings example

"EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT": "8261",
"EIKON.STREAMING.API.LOCAL.DACS.DPRM.INTERVAL": '43200000",
"EIKON.STREAMING.API.LOCAL.DACS.DPRM.DELAY": "50000",
"EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS":
"[\"dacs01\",\"dacs02\",\"dacs03\"]"

Important: DACS Permission Synchronization for Workspace is recommended — rather
than the DPRM service - to prevent misconfiguration or permission issues between the

Delivery Platform (formerly RDP) and local LSEG Real-Time Distribution System (formerly
TREP).

66 The EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT parameter is mandatory.

7 If not set to one of these values, DACS synchronization is not performed.

8 In permission proxy mode, the list of servers in the EIKON.STREAMING.API.LOCAL.SESSIONS setting is used.
8 If not set, the list of servers defined in the EIKON.STREAMING.APT.LOCAL .SESSIONS setting is used.
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Appendix F: Shared configuration

Configuration override order

The illustration below shows the override order for configuration settings’®, where commands
issued using the command line have the highest level of priority:

Command line statements

Company configuration
SHARED

Admin configuration

User details Product User
PLATFORM settings settings settings

User settings
(JSON file)

pzd
O
—
<
@
)
Q)
LL
zZ
O
@)

Creating a shared

configuration file

Once you have made your settings using e e s SEG ks

the Configuration Manager dialog, do the — « s s £ ol sl o 2 om0 8™ ol
following:

1. click Export

2. Use the Save As dialog to define a — =

file name and location

0 The Admin level shared configuration file is created using the Administration Panel tool. For further information, refer to the
Administration Panel Configuration Guide.
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Settings

The following table contains a shared configuration file example, showing where the setting
is found, and the selection or entry that was made in the example:

Setting example Description\Source

{
Configuration Manager > Network menu
"EIKON.CONNECTION.MODE": "private", Options:

— Internet
— Private network

Configuration Manager > Advanced menu

"REFINITIV.WORKSPACE.RUN_ABOVE_NORMAL_PRIORITY": Option:
"true", Run at the Highest Available Process Priority Level
"REFINITIV.WORKSPACE.TRADING.PRINTER_NAME" : Options:
"Microsoft Print to PDF", - Configured printers™
- Fax

— Microsoft Print to PDF

— Microsoft XPS Document Writer
— OneNote (Desktop)

— OneNote for Windows

Configuration Manager > Shared Configuration menu

"EIKON.INTRANET_OVERRIDE.ENABLED": "true", Options:

— Use a shared configuration
"EIKON.INTRANET_OVERRIDE.URL": "C:\\RwWTest\\Shared — Location path or URL (defined as
config\\MAIN. json", C:\\RwTest\\Shared config\\MAIN.json)

— This can be multiple location paths or URLs, delimited
using a semi-colon (;)

Configuration Manager > Client SSO menu

"CLIENTSSO_URL.ENABLED": "true", Options:
— Use aclient SSO
"CLIENTSSO_URL": "https:\\myapps.testsso.com", — Thomson Reuters (defined as

https:\\myapps.testsso.com)

"CLIENTSSO_REFINITIV_URL": — Refinitiv (defined as https:\\myapps.testsso.com)
"https:\\myapps.testsso.com",

Configuration Manager > Streaming menu

"EIKON.STREAMING.API.LOCAL.ENABLE": "true", Stream Data Retrieval options:
— From Refinitiv
— From a local LSEG Real-Time Advanced Distribution
Server (ADS)

"EIKON.STREAMING. JETQUOTES.DESKTOP.CONFLATION.ENABL  Streaming Conflation option:

E": “true", — Activate Conflation Rate

"EIKON.STREAMING. JETQUOTES .DESKTOP.CONFLATION" : — Conflation rate value drop down (3 seconds selected)
""3000",

Configuration Manager > Streaming > Servers menu’?

"EIKON.STREAMING.API.LOCAL.SESSIONS": LSEG Real-Time Advanced Distribution Server (formerly
"[\"wss:\\test-ads- ADS) options:
sharedconfig.com:15000\WebSocket\"]", — Protocol (selected wss:\\)

— Hostname or IP (defined as test-ads-
sharedconfig. com)

— Port (defined as 15000)

For additional servers that may be configured in the

shared configuration file only, see the Streaming protocols
section, below.

"t Network or connected directly
72 Up to eight additional servers can be configured. For further information, refer to the Configuring multiple servers section.

LSEG Workspace Installation and Configuration Guide
Document Version 124.08




Appendix F: Shared configuration 57

Setting example Description\Source
Configuration Manager > Streaming > DACS menu
"EIKON.STREAMING.API.LOCAL .DACS.USERNAME" : Options:
"permit_all_exchanges", — Username (defined as permit_all_exchanges)
"EIKON.STREAMING.API.LOCAL .DACS.POSITION": — Position (defined as
"%USERDETAILS . LASTNAME?%_%USERDETAILS.UUID", 9%USERDETAILS . LASTNAME%_%USERDETAILS . UUID)
"EIKON.STREAMING.APTI.LOCAL .DEFAULTSOURCE" : Main Feed options:
"IDN_RDF_2", — Feed Name (defined as IDN_RDF_2)
— Key Letter(s)
— Alias(es)
"EIKON.STREAMING.API.LOCAL .DESKTOP.ALIASES”: Other Local Feeds options:
“f\"Test Internal feed 1\”:[\”2\"]1}", — Feed Name (defined as Test Internal feed 1)
— Key Letter(s) (defined as Z)
"EIKON.STREAMING.API.LOCAL .DESKTOP.ALIASES” : — Feed Name (defined as Test Internal feed 1)
“f\"Test Internal feed 1\”:[\”INF_1\"]1}", — Alias(es) (defined as INF_1)
“EIKON.STREAMING.API.LOCAL .DISABLEDCONTRIBUTIONSOUR By default, contribution is allowed on all sources. This
CES”: "[\"ATS_GLOBAL_1\",\"NO_CONTRIB_ALLOWED\"]" setting is used to list sources on your local LSEG Real-

Time Advanced Distribution Server where contributions
are not allowed.

Any subsequent attempt to contribute data to one of the
listed sources is then rejected.

This setting should be defined to a JSSON-encoded array,
where each array entry is a real source name. For
example:

["ATS_GLOBAL_1", "NO_CONTRIB_ALLOWED"]

Configuration Manager > Other menu

"EIKONPROTOCOL . ISDEFAULTAPPLICATION": "true" Select the app that is used to open LSEG links:
— LSEG Workspace
— Eikon 4

}

For further information on the creation of a shared configuration file, refer to the Configuring
Workspace section.

Streaming protocols

In Workspace 1.2273, additional Refinitiv Wire Format protocols for LSEG Real-Time
Advanced Distribution Server may be configured using Configuration Manager or, manually,
in your shared configuration JSON file:

Protocol Transport Example

rwi+ws:\\ WebSocket rwf+ws : \\ads01.example.com:15000\WebSocket

rwi+wss:\\ Secure WebSocket rwf+wss:\\ads01.example.com:443\WebSocket
For example:

["ws:\\adsOl.example.com: 15000\WebSocket", " rwf+wss:\\ads02.example.com:44
3\WebSocket"]

Protocol support

Customer managed

From Workspace 1.22 onwards, the new protocols are supported for use through your Local
LSEG Real-Time Distribution System.

7 Workspace version 1.22 is the first release to support the new protocols.
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Where:
WebSocket API (JSON) Refinitiv Wire Format (Binary)
Version requirements rwf+ws rwf+wss
All versions of LSEG Real-Time Distribution System [ (]
LSEG Real-Time Distribution System version 3.7 (or [ J [ J [ J [ J
higher)

LSEG managed

The two services that are managed by LSEG — Hosted Market Data System and LSEG
Contributions Channel — use the rwf+wss:// protocol.
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I
Appendix G: Workspace

Messenger

Standalone

Workspace Messenger private line connectivity

You can use Workspace Messenger to send and receive text messages, photos, and stock
prices.

Once you have installed Workspace Messenger, if you require connectivity through a Private
Line, do the following:

1. Navigate to the Refinitiv Workspace shortcut:
a. Click Start
b. Scroll to Refinitiv > Refinitiv Workspace
c. Right-click Refinitiv Workspace and select More > Open file location
In File Explorer, right-click the Refinitiv Workspace shortcut and select Properties
3. Add the following parameters to the end of the Target field:
- --messenger-url="https://collab.platform.refinitiv.biz/eikonmessenger"

Embedded

Running Messenger traffic through a private network

To allow Workspace Messenger to route traffic through a private delivery network, you need
to request that Workspace is permissioned for Messenger Private Delivery, using the
following values:

Product code 100464
Permission Object name COLLRMPRIVATE
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Appendix H: Unsupported
packaging methods

Important: This section describes packaging methods that are neither recommended nor

supported by LSEG.

Supported methods

LSEG supports the installation of Workspace, using the downloadable executable file:
— On an individual basis. See the Basic Installation Guide.
— Using a command line statement. See Installing Workspace, in this document.

Unsupported methods

Customers may choose to deploy Workspace using the methods summarized below. While
we neither recommend nor, on an ongoing basis, support’* these approaches, the steps
outlined below are understood to work.

Packaging support

Customers are entitled to a session of up to two hours of free packaging support, provided by
one of our Technical Implementation Specialists (TIS). During this time, our specialist
focuses on providing guidance and offers expert advice on packaging Workspace.

Packaging support beyond this session will be chargeable. Should you require further
assistance from LSEG, contact your Implementation Relationship Manager (IRM).

Installing using an MSI installer

You may choose to use the MSI installer method in situations where you are blocked from
downloading and/or installing executable files, due to:

— A policy that is enforced on your computer, for example, by an antivirus product, or
— Your corporate firewall preventing access through their network
To do this:

1. Convert the RefinitiviWorkspace-installer_x.xx.xx.exe file to an MSI installer.
This can be done

. 2 Windows
using tools such as .
MSI Wrapper or l'-.'lnn'l'l.:u':? F'|_||.:.|:r. _1h|::ll . _ .
Advanced Installer Copyright (C)} Microsoft Corporation. All rights reserved.
2. Open PowerShell™® “Try the new cross-platform PowerShell https://aka.ms/pscore6
with admin privileges, S T
and navigate to the S C: \Downloads>

74 Refer to the Packaging support section. LSEG does not maintain test environments for these methods.
S For further information, refer to the online Microsoft PowerShell documentation.
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folder containing the .ms1 file.
3. To install Workspace using the quiet install method, use the command’®:

Start-Process RefinitivWorkspace-installer_x.xx.xx.msi -ArgumentList
"/quiet"

A system test is performed and LSEG Workspace is installed.

Deploying using Microsoft Intune

Using Microsoft Intune, you may be able to deploy Workspace to users in your organization.

Pre-requisites

The following are the pre-requisites for machines on which Microsoft Intune is used and
applies to the machines to which Workspace is to be deployed. These requirements may not
align with those of LSEG Workspace'":

— Use Windows 10 version 1607 or later (Enterprise, Pro, or Education editions)’®
— Machines (or devices) to which Workspace is to be deployed must be
— Enrolled in Intune, and
— One of the following™:
— An Azure AD registered device
— An Azure AD joined device
— A hybrid Azure AD joined device
— The installation file size must not be greater than 8GB.

Deployment overview
The Workspace installer file, Refinitiviorkspace-installer_x.xx.xx.exe, must be
converted to a file with an . intunewin extension. The tool used to do this can be found on
the Prepare Win32 app content for upload page.
Creating the temporary folders
1. Download the Content Prep Tool zip file and extract the tool (IntuneWinAppUtil.exe).
2. Inthe Windows %temp?% folder, create the following folders:

— 1-LSEG_Workspace

— 2-IntuneAppsLSEG_Workspace 8°

—  3-IntuneWinAppUtil
3. Inthe LSEG_Workspace folder, add the following files:

— RefinitivWorkspace-installer_x.xx.xx

— install.cmd

76 This command line instruction is used to install Workspace on one machine. For mass deployment, add the command to
your deployment portal (Microsoft System Center Configuration Manager, for instance).

7 For further information, refer to the Workspace System Requirements.

8 This requirement applies to all machines that are to be managed by Intune.

™ For further information about Azure device categories, refer to the Concept section under Azure AD device identity
documentation.

80 The 2-IntuneAppsLSEG_Workspace folder acts as the repository for the converted installation file.
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— uninstall.cmd
Sample install.cmd script:

START %temp%\1-LSEG Workspace\RefinitivWorkspace-installer_x.xx.xxx.exe --
user --silent --installpath="%localappdata%\Refinitiv\Refinitiv Workspace" -
-cachepath="%localappdata%\Refinitiv\Refinitiv Workspace\cachepath" --
installerlogpath="%localappdata%\Refinitiv\Refinitiv
Workspace\installerlogpath" --logpath="%localappdata%\Refinitiv\Refinitiv
Workspace\logpath" --shortcuts="%localappdata%\Refinitiv\Refinitiv
Workspace\shortcuts"

Sample uninstall.cmd script:

START %temp%\1-LSEG Workspace\RefinitivWorkspace-installer_1.22.303.exe --
uninstall --silent

4. Inthe 3-IntuneWinAppUtil folder, save the IntuneWinAppUtil.exe tool.

Running the conversion tool

Once the folders have been created, use the IntuneWinAppUtil.exe tool to create the
Intune file.

1. Open the 3-IntuneWinAppUtil
folder and double-click the
IntuneWinAppUtil.exe tool.

2. Atthe Please specify the
source folder prompt, type
the path to the first temporary
folder and press Enter.

For example:
C:\temp\1-LSEG_Workspace

3. Atthe Please specify the setup file prompt, type the name of the Workspace
installation file and press Enter.

For example:
RefinitivWorkspace-installer-win32-x64_1.23.269.exe

4. Atthe Please specify the
output folder prompt, type
the path to the second
temporary folder and press
Enter.

For example:

C:\temp\2-
IntuneAppsLSEG_Workspace

5. FortheDo you want to
specify catalog folder prompt, type N and press Enter.

The conversion tool starts converting the installation file to . intunewin format.

Installing through Intune

Once the . intunewin file has been created in the 2-IntuneAppsLSEG_Workspace folder,
follow the instructions in the Add, assign, and monitor a Win32 app in Microsoft Intune page.
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Use the information in the following table as a reference when configuring Intune:

Intune Name
Refinitiv Workspace - user mode

Refinitiv Workspace - machine-
autoupdate-peruser mode

Refinitiv Workspace - machine-
autoupdate-service mode

Refinitiv Workspace - machine-
autoupdate-no mode

Mode
--user

--machine-autoupdate-peruser

--machine-autoupdate-service

--machine-autoupdate-no

Command
RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --user --silent
RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --machine-
autoupdate-peruser
RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --machine-
autoupdate-service
RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --machine-
autoupdate-no
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Appendix I: Troubleshooting

In this section

— Microsoft Managed Desktop installation issue
— Crash information uploads

— JSON coding changes

— Error codes

— Logging

— Networking issues

— Using the Video Recorder tool

— Using the Logs Viewer

Microsoft Managed Desktop installation issue

Issue

Customers who are:

— Hosted on full Microsoft Managed Desktop (MMD) environments
— Installing or uninstalling Workspace 1.22 or higher, and

— Using a command line script

st.cc(962)

s launch fa

ss launct

ss host.cc(962)

ata manager impl prive

Cause

This error stems from the introduction of sandboxed processes®! in Electron version 20, as
the AppLocker Software Restriction policies may prevent the installation of binary files with a
SANDBOX flag.

Before starting a new installation or upgrade, the Workspace installer creates a spawn file
under %temp%, which triggers version and hardware tests. During the hardware test, the
GPU requirements of Workspace are checked.

At this juncture, the App Locker Software Restriction Policy:
— Flags the executable fille, preventing the GPU check

81 For further information, see Process Sandboxing | Electron.
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— Writes the GPU error message (above) to the Electron and Workspace installation logs,
and

— Creates the four binary flags, listed under Solution, below.

Solution

By exempting the blocked files, listed below, from the AppLocker policy, Workspace can be
installed successfully on MMD environments:

— Hash B949CF64DC938AC4D005CB683725E9343E09E3F3E6BIC3465F3FEE20F8FE3EE4
— Hash D66DCCC12FBF1D20C7FD7E2EOOE49DD8A0939F26BB4E5B01A482050A72B058C

— FQBN PublisherName="0=REFINITIV US LLC, S=NEW YORK, C=US"
ProductName="*" BinaryName="*">

— FQBN Publi sher‘Name="O=MICROSQI-—[ CORPORATION, L=REDMOND, S=WASHINGTON,
C=US" ProductName="MICROSOFTA,A® WINDOWSA,A® OPERATING SYSTEM"
BinaryName="*">

However, should you experience issues with this approach, contact LSEG Support who will
investigate the issue further. Support will require your installer logs and information related to
the installation.

Crash information uploads

If a crash occurs, Workspace sends the dump

file to the internal Support platform. ) A unespected error has occured.
. An unexpected error has red.
Whenever possible, Workspace also uploads Reﬁnmvwmpaca_neeusm be resarted.
X i ) X We are sor 1y for the inconvenience.
Test Uncaught Exception in MainError: Test Uncaught Exception in hain
SeSSIon Iogs to prOVIde more Informatlon to the atPruductCommandsDevtommand |_CrashMainProcesslavascript
Support teams &\is;rs\:SﬂﬂﬁﬁlG\AppD ata \L\E k\\R\Efk nitiv J\F;eafg zta)
at emitMany (events,js147:13)
N - at ProductCommands.emit (events.js:224:7)
Crash and Iog flles are Sent to the fo”oWlng at option.click (C\Users\U8003510\AppData' Local\RefinitiviRefinitiv
. | latf Workspace\resources\app.asar\Eikon eiken-commands js:60:18)
- at Menultem.click (C:\Users\USGGSSIG\APpData\LD(al\REﬁnitw\REﬁnitw
Interna Support p at Orm Workspace\resources\electron.asar\browseriapimenu-item,js:55:9)
t Function.executeCommand (C:\Users\U2005510\AppData\Lecal\RefinitiviRefinitiv
https\\dst platform reﬁnitiV Com\ Workspace\resources\electron.asar\ browser\api\menu,js:29:13)

JSON coding changes

The following additional, advanced syntax changes have been made to the coding of JSON
files:

— Add single line comments, using // at the beginning of the line
— Multiple line comments, using /* text text text */

— Empty lines are permitted

— Indentation errors are skipped and do not cause interruptions
— The last line of the file is not required to end with a comma

Error codes

The following error codes may be reported during an installation failure:

Error reported Code  Summary
UNSUPPORT_PLATFORM 100 Unsupported Platform.
FATLED_TO_INSTALL 101 Failed to install Workspace.
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Error reported Code  Summary

FAILED_TO_COPY_FILES 102 Failed to copy files to %AppData%\Refinitiv.

CANNOT_GET_FOLDER_SIZE 103 Cannot get folder size for stamping to Add/Remove program.

FAILED_TO_INSTALL_ADD_REMOVE_PROGRAM 104 Failed to install Add/Remove program.

FATLED_TO_INSTALL_WINDOWS_REGISTRY 105 Failed to install Windows registry.

FAILED_TO_CONFIG_PRODUCT 107 Failed to create/update config product.

FAILED_PREREQUISITE_CHECK 108 Failed prerequisites check.

ALREADY_INSTALLED 109 Already installed

NO_INSTALLATION_FOUND 110 No installation found

FATLED_TO_UNINSTALL 201 Failed to uninstall

FAILED_TO_UNINSTALL_CANNOT_REMOVE 202 Failed during uninstall process. Cannot remove Refinitiv
Workspace folder

UNSUPPORT_PLATFORM 300 Unsupported operating system.

INVALID_COMMAND_ARGUMENT 301 Invalid parameter used in installation command line.?

INVALID_ARGUMENT_VALUE 302 Invalid parameter used in installation command line

AEOILLAAI: L SR 303 Make sure that the path(s) entered in parameter(s) are compatible
with the chosen installation mode

ALREADY_INSTALL 310 Workspace is already installed

ALREADY_INSTALL_DIFFERENT_MODE 311 You cannot proceed with the installation, as Workspace is already
installed with a different installation mode

OFFICE_REGISTRY_CLI_NOT_SUPPORT 321 You must update Workspace to version 1.21 or higher to use the

--office-registry command

UPDATE_OFFICE_REGISTRY_CLI_NOT_SUPPORT 322 You must update Workspace to version 1.21 or higher to use the
--update-office-registry command.

UPDATE_BLOCKED_BY_OFFICE_REGISTRY 323 Update is blocked because your office registry is set to HKCU.
Reset using --update-office-registry=HKLM before
performing the update again.

NOT_ALLOW_ROLLBACK_BY_OFFICE_REGISTRY 324 Rollback is blocked because your office registry is set to HKCU.
Reset using --update-office-registry=HKLM before
performing the update again.

SYSTEM_CHECK_FAILED 350  The installer was unable to run the system test successfully
SYSTEM_CHECK_UNKNOWN_RESULT 353 The installer was unable to run the system test successfully
NOT_ENOUGH_DISKSPACE 351 Insufficient disk space on which to install Workspace
NO_ADMIN_RIGHT 352 Workspace installation requires Administrator privileges
FILE_TIS_LOCKED 400 Process stopped as Workspace file(s) in use
FILE_IS_MISSING 401 ¥Yorkspace installation executable does not contain all required
iles
INSTALLER_FILE_CORRUPT 451 Workspace installation executable is corrupt
NO_INSTALLATION_FOUND 500 Workspace installation file was not found
MS_OFFICE_PROCESS_IS_RUNNING 501 Installation stopped as Microsoft Office applications are running
FATLED_TO_HANDLE_FILE 801 Unable to access Workspace installation files
FAILED_TO_CONFIG_PRODUCT 802 Unable to configure product 82
FAILED_TO_ADD_REMOVE_PROGRAM 810 Unable to update Add/Remove Programs
FAILED_TO_ADD_WINDOWS_REGISTRY 811 Unable to update Windows registry
UNKNOWN_ERROR 999 Unknown error

Logging
Uploading Workspace logs

You can upload Workspace logs by using:
— A menu option
— Excel launcher

82 See Workspace Help parameter options.
8 In this event, contact Support. You will also be asked to provide your installation log file.
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Menu option

— From the Help menu, select Upload
logs.

Excel launcher

If you are logged into Excel:

1. Press Shift+Ctrl+Space.

2. Inthe Search window, type /10g.

AutoSave S Bookl - Refinitiv is anline

Get Data Apps Data Tools

/Iog|f Upload Logs

Upload Logs
&

3. Click Upload Logs.

Log upload workflow

By user request or if a crash occurs, Workspace
sends the contents of the application logs folder to
the internal Support platform:

https:\\dst.platform.refinitiv.com\

To save bandwidth, log uploads are sent in chunks
of no more than 5Mb. Additionally, logs that have
already been uploaded are not uploaded again.

You can also upload log files to the desktop support
site using the following command line:

RefinitivWorkspace.exe --upload-Tlogs

File Home Insert Page Layout Formulas Data Review View Help Refinitiv 1} Share i Comments

@ df{z .’.5} & Lists ? i D £ @ Pause Updates ff"(; [B] Manage Requests |l Chart ul| Library % Online ~
JXE g2 17| 4 JX o
E - 3¢ Utilities ~ |l Refresh ~ B Manage | @ Help~
Templates  Build Search App  Screener Insert Refresh Datastream
Formula Library ~ Chart | All Workbooks ~ Formula [ New Request Table > | Edit £} Settings
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|

0, NESF 8 oNT £

PRICING SEARCH

OVERVIEW

Datastream Options ~

Tab to select

ILOG

Upload Log Files

Upload LSEG Workspace log files?

Upload Log Files

LSEG Workspace log files have been successfully uploaded.
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Log upload troubleshooting

For troubleshooting purposes, the settings® shown in the table below can be written to the
user-settings.json or machine-settings.json file:

EIKON.LOGSUPLOAD.VERBOSEOQUTPUT set to true to have some output generated in the console.
ETKON. LOGSUPLOAD .DEACTIVATEENCRYPTION set to true to send the logs without encryption.
EIKON.LOGSUPLOAD.WRITETEMPFILESONDISK set to true to write the original and the crypted zips in the
%TEMP% folder.
EIKON.LOGSUPLOAD.TESTDECRYPTIONLOCALLY set to true to test that decryption works locally (useful with

VERBOSEOUTPUT and/or WRITETEMPFILESONDISK).

Networking issues

Tools

After installing Workspace, you have the Web Logger
option of using the web logger command to Activate Web Logger
troubleshoot networking issues. To do this:

— Use the command RefinitiviWorkspace.exe --web-logger, or
— Activate it using the Web Logger checkbox under Configuration Manager > Logs:
To troubleshoot networking issues:

1. Launch Workspace with the --web-1ogger parameter, using the Command Prompt, or
through the Configuration Manager.

2. Enter your credentials and login.
Navigate to the 1og folder location.

4. Open the most recently created desktop log file (web-requests.log) &. This file is
created and available with all captured web calls from Workspace.

Resetting Electron application data

You can use the following parameters to delete application data — configuration files, caches,
preferences, and settings — resetting Electron.

Important: Close all Workspace applications before running these commands.

To do this, depending on your requirements:

— Run RefinitivWorkspace.exe with a parameter, or

— Select a cache clearing function under Configuration Manager > Cache
Depending on the option chosen, resetting the cache has the following effect:

Configuration Manager Parameter Effect

function

Clear all cache —-resetCache Resets the product cache of Workspace to its default state.
That is, as it would be after a fresh installation.

Clear Electron cache --resetElectronCache Reset the Electron cache of Workspace to its default state

84 By default, all these settings are set to FALSE.
8 When Workspace shuts down, it generates both the web-requests. Tog file and a HAR-based topology log file.
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Using the Video Recorder tool

The Video Recorder tool allows you to capture and save video footage of your entire desktop
or a particular screen. This is particularly useful for
capturing issues you are experiencing with your
environment to provide additional information to
Support.

You can start the tool from the Help menu or by using
a parameter. — OVERVIEW

Starting the tool from the Help
menu

To do this:
1. Open the Help menu by clicking the ? icon.

Video Recorder

2. Select Video Recorder from the menu.

Starting the tool using a parameter

Run Workspace with the --video-recorder parameter. This can be done either by:
— adding the parameter to the application shortcut by editing its properties, or

— using the appropriate command line statement:

Windows "% OCALAPPDATA%\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --video-recorder
macOS " /AppTlications/Refinitiv Workspace.app/Contents/MacOS/RefinitivWorkspace" --args --video-recorder
The f0||0W|ng d|alog |S [ LSEG Workspace - Video-Recorder - O X
displayed: Start
N

Capturing a video

To capture avideo, do
the following:

1. Click Start.

2. Inthe dialog that is
displayed, choose
whether to capture
video of your whole
desktop or of a
specific screen.

[ LSEG Workspace - Video-Recorder - [m} X

Please select a source

Entire screen
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While the video is recording, a dialog is displayed which
shows the current size of the video file, as it is recording.

3. Once you have captured the content you require, click Stop.

4. Then, in the main
dialog, click Save.

A Windows Explorer
dialog is displayed,
with the Downloads
folder open, by
default.

5. Optionally, navigate
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LSEG Workspace - V.. — O X
| stop | 0.903 MB
B LSEG Workspace - Video-Recorder - O X

| Start | | Save | 5.04 MB

e D SURP_SNIE U NY NCNPe

B Desktop LSEG expressive  LSEG UBA logo
icons pack pack

MaxxAudioPro
[5] Documents

& Downloads v Along time ago (4)

D Music
= Pictures n

B Videos ’ 3 ) 3
- 05 (C) .

v Adobe Acrobat

node_modules htenl RoboHelp_15 LR v

File name:

Save astype: WEBM File (*.webm) v

to a different
download folder.

~ Hide Folders

Click Save.
Contact Support, who will guide you regarding the submission of this file.

Using the Logs Viewer

The Logs Viewer facility allows you to view a
comprehensive and filterable list of log entries that were

captured in the main and other files. a ol oo

elp & Support

You can start the facility from the Help menu or by using
a parameter.

OVERVIEW

Opening the facility from the Help
menu

To do this:
1. Open the Help menu by clicking the ? icon.

tion Manager

Logs Viewer

2. Select Logs Viewer from the menu.

Opening the facility using a
parameter

Run Workspace with the --Togs-viewer parameter 8. This can be done either by:
— adding the parameter to the application shortcut by editing its properties, or

— using the appropriate command line statement:

"%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --logs-
viewer

"/Applications/Refinitiv Workspace.app/Contents/MacOS/RefinitivWorkspace" --args --
Togs-viewer

Windows

macOS

8 See the Logs Viewer parameters section.

LSEG Workspace Installation and Configuration Guide
Document Version 124.08


https://my.refinitiv.com/content/mytr/en/helpandsupport.html

Logs Viewer parameters

The table below lists valid parameters for the --1ogs-viewer command line statement:

Parameter
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--logs-viewer

--logs-viewer=<prefix>

--logs-viewer=<file>

--logs-viewer=“<folder path>”
--logs-viewer="“<folder path>\*"

--logs-viewer="<folder
path>\<prefix>"

Description

Select the main file, which is the log of the current Workspace session, in the

current log folder
Select all files in the current log folder

Select the files in the log folder that have the defined <prefix>. Where <prefix> is

one of the following:

— main— Workspace desktop log
— excel —Workspace for Excel log

— renderer — Workspace window rendering log

— node — Node.js log
Select the specified log file. For example:

--Tog-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace

Logs\Desktop.20230104.151635.p8956\renderer-1-

r6.20230104.p22728.70g"

Select the main log file from the specified <folder>. For example:
--Tlog-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace Logs"

Select all files from the specified <folder>.

For example:

--log-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace Logs\*"
Select files with the specified <prefix> from the specified <folder>. For example:

--log-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace

Logs\renderer"

Overview of the Logs Viewer panel

Tags are extracted from the

log text when there is an Select from a list of all lo
What — the type of . 9
e Tt s b oin info, error, warn, and so on, files, then click GO to
excel. renderer. and prefix confirm your selections

Header — Containing
file name and length

so on.
Where — file name, if
more than one of that I Logs Viewer - A Use\ USGRAT3 VappD
type, and line number
When — date and time W LEED
stamp (local or UTC) B o o)
Shift — time variance ; idnf:uanaz)
from first log entry B
Level — error,
warning, info, debug, s
or verbose > Files
Tags — [XYZ] markers = Columns
found in the log entry ¥ What

¥ Where
¥ When
B shift
+ Level
¥ Tags

L Workspace Lglh<\Desktop.20230308.123602.p75200main. 20230308.p7520.0og

: ] Where | when level Jmgs ]

807 2023-03-08 12:36129.684 @ info
808 2023-03-08 12:369.685 . info
809 2023-03-08 12:36129.685 @ info

810 2023-03-08 12:36829.686 . info

023:03:08.12:3609.686 @ info

812 2023-03-08 12:36:29.696 /f\ warn lconsole

813 2023-03-08 12:36:29.703 (@) eror console

¥ Options

B show Dates as UTC
+ Show Dates as Local
# Auto-scroll

The contents of the
selected files are
saved to a .csv file in

814 2023-03-0§12:36:29.703 (@) error console

Searchl | <<ff>>

- 1368 lines (+9) -

Controller: ]san? 552

AppServer - Register Recentl
YUsedItem: json:530

AppServer - Register CSMGe
ttingStarted: json:513

AppServer - Register DeepLi
nking: json:499

AppServer - Register Downl
oads: json:485

AppServer - Register UsageT

racking: json:509

Status Code 404 (Not Foun
d) when requestFullRespons
e: json:175

(node:7520) UnhandledPr
omiseRejectionWarning: Er
ror: Net request was unsu
ccessful: Not Found.

> at HttpResponse.<anon
ymous> (C:\Users\UG084
Z31\AppRataiLocal\R
v\Refinitiv Workspace\reso
urces\app.asariynode_mod
ules\df-core\src\net\index.
ts:71:28)

> at HttpResponse.emit
(node:events:406:35)

> a... (300/955)

(node:7520) UnhandledPr |
omiseRejectionWarning: U

Show dates as UTC — date and time is converted to UTC time

%LOCALAPPDATA%\Tem
p\Refinitiv
Textual search of
all filtered log zone.
records

Show Dates as Local — Default. Date and time shown in local

time zone.

Auto-scroll — Updates to a single selected file are tracked and
the new data is added. Select this to scroll automatically to the

bottom when an update occurs.

Log entry list, where
the background color
indicates the type of
entry:

Error

Warn

Info

Debug

Verbose
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I
Importing files

Under the Files filter, log files held in folders
that are not listed in the Logs Viewer can be

Logs Viewer - C:\Users\US02473 1\AppData\Local\Refinitiv\Refinitiv Workspace Logs\Desktop. 20230309.020524, pzzg
v Files g vhat [where |

J

Desktop.20230309.080524.p22632

87 M [#14] renderer-9-r15.20230309.p26512.log

. . . -«
Imported into the viewer. ¥ [#1] main.20230309.p22632.log B 1899 2023-
| | [#2] node-brokers-node-instance.20230309.p12012.log
. B [#3] renderer-1-r5.20230309.p5040.log
TO do SOt B [#4] renderer-10-r15.20230309.p26512.log B 1901 2023-({
. W [#5] renderer-11-r17.20230309.p12712.log
1. In Windows Explorer, open the folder 8 [#6] renderer-12-r13.20230309.p27124.log B 0 2023'“;
.. . . B [#7] renderer-2-r7.20230309.p25868.log
containing the flle(S) to Import. W [#8] renderer-3-18.20230309.p7196.Iog bd
B [#9] renderer-4-r10.20230309.p11296.log B 1903 2023-
1 B [#10] renderer-5-r11.20230309.p2720.log
2. Select the flle(S). B [#11] renderer-6-r12.20230309.p8952.log B 1905 2023-0
. . . B [#12] renderer-7-r13.20230309.p27124.log
Drag the files into the Logs Viewer panel W [#13] renderer-8-113.20230309.p27124.I0g

— When you release your pointing device, the
files are added to the viewer under the
folder in which they were located.

Using the Actions menu

The Actions menu, an ellipsis found under the Actions column, can be used to copy the

Contents Of SpeCIfIC IOg file entries. 2.20230305.080524.p22632\main.20230309.p22632.l0g - 1742 lines ... - a x
H . i 5 e) -

To open the Actions menu: pove [mos e ] actions]

@ info Appservler :jRegist
) er Downloads: jso

1. Hover your cursor over the Actions column of the —
« @ info AppServer - Regist

entry to copy. eF WebsocketAgDr

egation: json:552

* @ info AppServer - Regist

— An ellipsis appears. erSterage: o

2. Click the column to display the menu. A vern (Nt Eoun e

, . o feonize .
Choose from the following options: Do e ||
nhandledPromise |
Copy raw line Copy the original data from the log file to the e
Clipboard. uest was unsucc |

This copies the entire contents of the line, g rul: Not Foun |
including date, time, and so on.

Copy Text Column Copy the content of the Text column to the
clipboard.

>. at HttpRespo
nse.<anonymou i
s> (C:\Users\Us |

87 You can copy the files into the existing folder by holding the Ctrl key before releasing your pointing device.
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Appendix J: Known issues

Datastream for Office issues

Warning: As a result of these issues, existing Datastream for Office (DFO) users should

not yet upgrade to Workspace 1.24. A patch release of Workspace correcting this issue
will be released early in Q1 2024.

The following issues have been identified that would impact DFO users only:

— When the Autorefresh parameter is set to Off in a DSGRID formula, the refresh of the
formula may hang and will display Retrieving data indefinitely.

— The copying and pasting of a DSGRID formula should use cached data, but currently
does not.

— When the Compile option is selected in Excel, a VBA alert is displayed when opening a
new Request table.

— When cell referencing in the formula builder, the cell to return the formula is moved to the
cell reference location, causing an error.

DPRM connection issue

If DPRM-related settings are read incorrectly, it may result in DPRM failing. In this case, the
No working server available for DPRM log file error message.

Important: The workaround, below, is only required for installations of Workspace 1.23

and has been fixed in the Workspace 1.24 release. Therefore, if you have upgraded to
1.24, these settings will need to be removed.

As a workaround, the following settings should be added to your configuration file:

{

"EIKON.STREAMING.API.__CORE__.PLUGINS.ADDITIONAL.LOCAL": "%.7%,%.8%",
"EIKON.STREAMING.APTI.LOCAL .ADDITIONAL.SESSIONS.1":
"%EIKON.STREAMING.API.LOCAL .DACS.DPRM. SERVERS%" ,
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.2":
"%EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT%",
"EIKON.STREAMING.API.LOCAL .ADDITIONAL .SESSIONS.3":
"%EIKON.STREAMING.API.LOCAL .DACS.USERNAMEX%" ,
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.4":
"%EIKON.STREAMING.API.LOCAL.DACS.FORCECASE%",
"EIKON.STREAMING.API.LOCAL .ADDITIONAL.SESSIONS.5": "%USERDETAILS.UUID%",
"EIKON.STREAMING.API.LOCAL .ADDITIONAL.SESSIONS.6":
"%EIKON.STREAMING.API.LOCAL.DACS.DPRM.INTERVAL%"

}

Retrieving permissions

If you use this workaround, the default for retrieving permissions from the LSEG Real-Time
Advanced Distribution Server, to which you are currently connected, will not work. As such,
you need to specify a value for the following setting:

’EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS ‘
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Limitations

There are several impacts of these additional settings that are described below.

Defining additional local connections

If you use additional local connections, you will be limited to two. These are the connections
configured using the following settings:

EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.7
ETKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.8

Using Configuration Manager

This workaround will severely impact use of Configuration Manager.

Certain components of Configuration Manager — Streaming feeds, for instance — will not
initialized properly. As such, any changes made in Configuration Manager will not persist
and, therefore, will have no effect on Workspace.

Exporting data to Excel

This affects users who are not permitted to
access the Windows operating system
tool®®, PowerShell, only.

An error message may be displayed when
attempting to export data to Excel.

® This has been noted to impact users of
the SDC PLATINUM application
especially.

Excel add-in loading

ISSUEes

Trust Center policies

If the Group and/or Microsoft 365 Trust Center policies are set to deny the use of Web add-
ins, certain Workspace add-in menu ribbon items, such as Deals BI, may not load.

To resolve this issue, do the following:

1. Open a Microsoft 365 file (Word document, Excel spreadsheet, ...)
2. Open the File menu

3. Select Options

4. Inthe Options dialog, select Trust Center

8 For a list of required operating system tools, refer to the System Test Guide.
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5. Click the Trust
Center setti ngS. s Trusted Publishers Trusted Web Add-in Catalogs

Trusted Locations
bUtton Trusted Docurments Use these settings to manage your web add-in catalogs.
J B} @\;]gm‘t allow any web add-ins to start.
6. Select Trusted Don't allow web add-ins from the Office Store to start,
Ad d _i n Catal Og S Add-ins Mext time Office starts, clear all previously-started web add-ins cache,
y ActiveX Settings Trusted Catalogs Table
7- UnCheCk the Don t Macro Settings
‘ou should only add a catalog if you trust its owner. You may also select one of each catalog type to show in the
al I OW any Web Protected View insert add-in menu. We will automatically start web add-ins from your insert add-in menu catalogs when opening
documents.
1 Message Bar
add—lns to Start 9 Catalog Url: Add catalog
M Zoden ————t it =

checkbox

Workspace installations without automatic update®

For users installing Workspace using ——-machine-autoupdate-no, the Excel add-in does
not load correctly on non-virtual machines. This is because the default location of the Office
registry key is registered at HKLM.

To correct the registry key location, use the command:
<install path>\RefinitivWorkspace.exe --update-office-registry=HKCU

Installing standalone Workspace Messenger

For Workspace 1.21 only, installation or update of Workspace Messenger alone is done
using command line statements. That is:

Installation RefinitivWorkspace-installer_x.xx.xx.exe --<mode> --messengeronly
Update RefinitivWorkspace-installer_x.xx.xx.exe --<mode> --messengeronly
Uninstallation <install path>\Refinitiv Workspace\RefinitivWorkspace.exe --uninstall

Contributions (RtContribute)

The Refinitiv Workspace - Excel (Workspace ribbon) add-in was added in Workspace
version 1.16. The following list summarizes the known issues and their solutions or when
they are to be addressed.

Issue Solution/To be addressed in

RTDS requires updating to a new Data Dictionary version.

LSEG Real-Time Advanced Distribution Server (formerly ADS) version Install version 3.5.2 L3 °° or higher.
3.5.2 L1 does not support the contribution from Workspace Excel.

POS and LANGUAGE parameters are not supported. Requires sending Only UTF-8 is supported by the API
datain RMTES encoding.

LSEG Real-Time Advanced Distribution Server version
Issues

There were several issues with the handling of WebSocket connections in the initial release
of version 3.5.2, which were only partially resolved in 3.5.2 L2.

89 PCN206237 provides more information about this fix.
% See also Creating an internal connection.
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Further issues concerning WebSocket connections were addressed in the L3 release,
together with minor changes to the default settings, which improved the handling of larger
messages.

Virtualized environment issues

Important: If you encounter an issue; LSEG requests that you confirm the issue has been

reproduced in a non-virtualized environment.

CVAD environments

This section lists all known issues for running Workspace on a CVAD environment:

Subject Jira XenApp XenApp Xen
reference pub. app pub. d’'top Desktop

RTGet template which has 10k functions is not responding EFO-8412

on applying "save as val- agreeues-Workbook"

Refinitiv Workspace - Excel is not automatically sign in and EFO-8579 [ J (]

retrieve the data when Open saved Functional template +
native excel via command line

HelpApi request doesn't work HELP-5828 ([ J
All menus are displayed as separate entry in taskbar SAP-9231 [ J
Toast Ul is displaying as separate entry in taskbar SAP-9233 [ J
Notification Centre: Toast still appears when user activate SAP-9617 [ J
Focus Assist on local machine

There is a small black area around toasts SAP-9620 [ J
Shortcut (ALT + S) doesn't work SAP-10009 ([ J
RW in XenApp does not support custom protocols SAP-10157 [ J
Black areas are shown near guidelines and snapping lines SAP-10399 [ J
Snapping/grouping features breaks after moving a tile SAP-10368 [ J
(moving frame)

Black screen is displayed around opened window for area SAP-10785 [ J
and full screen screenshot

Messenger on Citrix XenApp environment intermittently SAP-11267 [ ]
freeze while typing in the text box

File type is not added into save dialogue SAP-14187

Unknown container type and app-name into UsTracking SAP-18302

evet for Tile, Modal window

If the 'Position of Toast' sets as 'Bottom - Right or Left', it's SAP-24424 [ J
not working as expected

Three horizontal dots (ellipsis) option is not appearing in SAP-24438 ([ J
the toast notification

Not able to close the popped-out conversation in the SAP-24439 [ J
system task bar

Deep links are not opened on virtual desktop machines SAP-25517

[Widely:] Palo Alto Networks TS Agent can raise problems

- whitelisting

VMware environments

This section lists all known issues for running Workspace on a VMware Horizon 8
environment:

Subject T FEETEE Horizon virtual
apps

There's only 'Close window' in the task bar SAP-10823 [ J

Published Apps - Do not disturb option is activated on Published Apps when SAP-10972 °

Focus assist is OFF in OS settings

LSEG Workspace Installation and Configuration Guide
Document Version 124.08



Appendix J: Known issues 77

Subject Jira reference Horizon virtual
apps
Published Apps - Impossible to copy screenshot to clipboard for Virtual App SAP-11011 [ J
Tiles - Snapping line and guideline are visible only after dropping a tile SAP-11025 [ J
Tiles - Group movement is not working properly SAP -11026 [
Tiles - Single tile resizing works for snapped or grouped tiles SAP-11027 [
Impossible to open deep link SAP-11955 [ J
Published Apps - RW desktop 1.19 is not resized SAP-22571 [ J
Tiles - Pinned tile manager can be moved SAP-22620 [

SSL inspection support

LSEG does not support or enforce SSL inspection, sometimes referred to as TLS/HTTPS
Interception.

If clients use SSL inspection, they must configure URL filtering profiles not to enforce SSL
inspection on LSEG domains, such as *.refinitiv.com, *.refinitiv.net, *.refinitiv.biz.

Real-Time server disconnections

In the event where the LSEG Real-Time Distribution System disconnects immediately
following a successful mount, refer to Creating an internal connection.

Cache path definition

An alternative cache path can be defined for Workspace during its installation, using the
parameter:

RefinitivWorkspace-installer_x.xx.xx.exe --cachepath="<folder_path>"

However, currently, this does not re-route the entire content of the Refinitiv Workspace
folder in the cache. That is, while the eTectron folder is moved to the new location, the
following subfolders are not:

— Config

— Dictionaries

— Data API Proxy
— File Links

Signing in automatically

. : : <
When users first log into Workspace, they have the option of

choosing to sign in automatically in future, which creates a cookie in
the electron cache for the user.

However, if electron is upgraded to a higher version, the cache is
cleared and users are expected to sign in again. =

® As this may occur many months later, users may have lost their
credentials.

Contact Us | Privacy
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I
Rolling back

If your instance of Workspace was upgraded automatically, you can return to the previous
version of Workspace by using the rollback parameter in the command line:

"<Install Path>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe"
--rollback

However, this command also disables the automatic update feature for subsequent releases
of Workspace.

Rolling forward command support

Due to changes to the Workspace architecture, the --rol1forward command line
parameter is only valid for version 1.19 or higher. Also, this command can only be used after
a --rollback operation has been performed.

https://my.refinitiv.com/content/mytr/en/productsupport.htmi
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